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1 RECORDED INFORMATION DISTRIBUTION 

EQUIPMENT (RIDE) 

1.1 Introduction to the RIDE Platform Interface 
The RIDE application is web-based and supports Internet Explorer from version 5.0 
onwards. All testing has been performed using this browser. It is also expected to work 
with other browsers but this cannot be guaranteed for all combinations of RIDE and 
Browser software versions, because it has not been as extensively tested. 

The web interface employs the usual features such as links, drop-down lists, dialogue 
boxes and check boxes etc. A mouse is used to select items, links and menu options. 

For the purpose of these instructions, it is assumed that the equipment is correctly 
installed, and is functioning normally. 

If the user is unfamiliar with Windows, or with the use of a mouse, it is suggested that the 
on-line Microsoft Windows Tutorial may be of assistance. There also follows a brief 
explanation of some of the terms used in the following text. Further assistance on using 
Windows can be gained from the Microsoft Windows/NT User Guides. 

The screens shots and descriptions in this manual refer to Windows XP and may differ 
slightly if another operating system is used. 

 

1.2 Brief Explanation of Terms 
Choose:  Use the mouse to pick (click) an item from a menu or dialogue box to 

begin an action. Alternatively, type the key letter (underlined) for the 
selected item to begin the action. 

Click Press and quickly release the left hand mouse button. 

Right click Click on the item using the right mouse button. 

Double click Press and quickly release the left hand mouse button twice. 

Close Choose Close from a window control box menu or dialogue box, or 
use the mouse to click the Close Button in the window title bar. 

Open Enlarge an icon to a window by double clicking on the icon. 

Point Use the mouse to point at an item and highlight it, without clicking a 
mouse button. 

Scroll bars The vertical and/or horizontal scroll bars appear along the edges of a 
window when a document, a list, or a picture is too large to entirely fit 
within the viewing window. Use the scroll bars to move the viewing 
window around the document, list, or picture. 

Select Mark an item or command button for subsequent action by clicking 
on the item or box with the mouse, or using the appropriate key 
strokes. 

Dialogue A window that appears temporarily, requesting information or options 
to be chosen. 
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1.3 Document Conventions 
This document uses several conventions to facilitate recognition of instructions. 

 Microsoft and other third-party software application window titles are depicted in dark 
blue, bold font.
Example: Clicking the calendar icon will display the Calendar dialogue. 

 All RIDE web interface page titles are depicted in dark blue, bold font with the last word 
of the page title in a larger font size.

Example: From the service administration main page in ... 

 All cross references are shown in light blue font.

Example: From the service administration main page is displayed in Fig. 10. 

 Data that is to be selected will be expressed in italicised letters.
Example: Choose England from the from the By Region drop down list 

 Command buttons, text field names and menu items are shown in bold letters.
Example: From the File menu, click the Save button. 

 The labels that appear on the keys of the keyboard are presented in upper case and 
enclosed in angle brackets.
Example: <ENTER><TAB> 

 Words and commands that must be typed as instructed are presented in the Courier 
font.

Example: 10.70.7.53<TAB>www.bt.se 

 A Note emphasises or provides further information concerning important points of the 
text, or supplies information that applies only in certain cases.
Example: Note: The entry fields are case sensitive. 

 Text within angle brackets indicates that the string should be replaced.
Example: telnet <IP address> should be replaced as follows telnet 192.168.0.0 

  continued overleaf
This indicates that further text or graphics describing the topic appear on the following 
page. 

 * This symbol appears next to a data input field when data entry is mandatory.

1.4 Where to find the latest version of this guide 
 
https://www.inboundservices.bt.com/HelpFiles/additional/ride_spug.pdf 

http://www.bt.se/
https://www.inboundservices.bt.com/HelpFiles/additional/ride_spug.pdf


Ride Web Interface Service Provider User Guide 

Issue A3i 08 August 2019.  

Copyright © BT 

 

 

 

2 SETTING UP YOUR BROWSER 

To achieve this, you need: 

 A computer with Internet access

 A browser. You are recommended to use IE4 to IE5.5. Netscape 4 to 4.7 has been 
used but has not been as extensively tested. . Potentially, difficulties may also be 
experienced with new browsers that have not yet been tested to ensure compatibility 
with our system. The following description is valid for Internet Explorer.

 A PC - minimum requirements: 486/66 Processor, 12MB RAM memory (24MB for 
Windows NT),50MB hard disk space, a compatible operating system, e.g. Windows 
95/98/NT. You may be able to gain access to Web Interface from any device with a 
web-enabled browser that supports 128-bit encryption.

 You are recommended to define your screen size as 800 * 600.

2.1 128 Bit Encryption 
Before accessing the RIDE web interface the user must first ensure that the Internet 
browser being used supports 128-bit encryption. 

To determine the level of encryption employed by the browser select About Internet 
Explorer from the Help menu. This opens the About Internet Explorer window. Cipher 
strength should be at 128-bit. 

If the cipher strength is less than this, access to the RIDE web interface cannot be 
established. 

Download an upgrade to 128 bit encryption from; 

http://www.microsoft.com/windows/ie/downloads/recommended/128bit/d 

efault.mspx 

Your browser version can be found in the About Internet Explorer window. 
 

2.2 Default Settings 
To access the RIDE web interface, a number of changes must first 
be made to the default settings within Internet Explorer. These 
include the security policies for ActiveX, Cookies and Java, 
together with other advanced security parameters. 

A low security policy is required to enable access the system so 
the RIDE web site can be set as a trusted site. This is performed 
as follows: 

 

Fig.2.1 Accessing Internet Options 

http://www.microsoft.com/windows/ie/downloads/recommended/128bit/d
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1. From the Tools menu of Internet Explorer, select Internet Options as shown in 
Fig. 2.1. The Internet Options window is displayed. 

2. Select the Security tab from the top of the window. Click on Trusted sites and 
then click Sites…(Fig. 2.2). 

 

Fig. 2.2 Internet Options - Trusted Sites 

3. The Trusted Sites dialogue box is displayed as shown in Fig. 2.3. Enter the full 
RIDE web address into the Add this Web site to the zone: text field as shown. An 
alternative site address may be used (https://www.bt.com/ride). 

 

 

Fig. 2.3 Internet Options - Security - Trusted Sites 

http://www.bt.com/ride)
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4. Click Add to enter the address into the Web sites: box. 

5. Ensure that the Require server verification (https:) for all sites in this zone checkbox 
is ticked. 

6. Click OK to close the Trusted Sites dialogue box. 

7. In the Internet Options window on the security tab, click Custom Level… to 
display the Security Settings dialogue box as shown in Fig. 2.4. 

 

Fig. 2.4 Internet Options - Security - Security Settings 

8. Reset the custom settings to low by selecting Low from the Reset to: drop-down 
list and then click Reset. 

9. Click OK to close the Security Settings dialogue box. 
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10. In the main Internet Options window, click the Advanced tab to display the 
advanced settings as shown in Fig. 2.5 

Fig. 2.5 Internet Options - Advanced 

11. Scroll down to the security section and check the boxes as displayed in Fig. 2.5. 

12. Once the boxes have been checked, click OK to close the Internet Options 
window. 

 

2.3 Completion 
1. To ensure that all settings have taken effect, close down the browser by clicking the 
Close button in the window title bar, and re-launch Internet Explorer. 

2. Enter the site address into the address bar and click Go (see Fig. 2.6). 
 

Fig. 2.6 Internet Explorer Target Field 

The RIDE login page, illustrated in Fig. 3.1 is displayed. 



Ride Web Interface Service Provider User Guide 

Issue A3i 08 August 2019.  

Copyright © BT 

 

 

2.4 Security certificate date. 
You may recieve a screen prompt, which tells you that your security certificate is out of 
date. 

Assuming your certificate is not out of date, this may be due to a problem with older 
versions of browsers, which do not correctly process date information. Unfortunately, the 
security certificates that are embedded in older versions of Netscape (Netscape version 
4.05 and earlier) expired on 1 January 2000. This means that secure sites are no longer 
accessible to these sorts of browser. You may wish to upgrade your browser to a more 
recent version. Instructions for doing this can be found via the 'help' icon on your browser. 

 

3 LOGGING IN 

3.1 Logging in for the First Time 
Your User Identity (ID) will be provided by the System Administrator, and your initial sign- 
on password will be sent to you via email. 

 

Fig. 3.1 The Login Screen 

At the web interface your account login screen, enter your User ID in the Log in name 
field. 

Note: Your User ID is case-sensitive, and must be typed in exactly as shown by your 
administrator. 

1. Type in your password in the Password field. 

Note: Your password is case-sensitive, and must be typed in exactly as displayed in the 
email. 

2. Click Login, or press <ENTER>, to initiate login. After successful validation of User 
ID and password the Warning page appropriate to your Service Provider and your access 
privileges opens, as illustrated in Fig. 3.2, which shows a typical warning. 
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Fig. 3.2 Web Interface Access Warning Page 

3. Read the Warning on screen, and click Yes to complete the login. 

The first time you log in, the change password / change prompt page is displayed. 
 

Fig. 3.3 Change password - Change prompt 
 

3.1.1 Change Password 
1. Enter your old password in the Old Password text field i.e. the initial password 
provided by email (case sensitive). 

2. Enter your new password in the New Password text field. The rules governing a 
valid password are: 

 A password must contain between 8 and 16 characters.

 There must be no double characters.

 Adjacent characters must not be in numerical or alphabetic sequence, neither forwards 
nor reverse. This is immediately apparent for numeric and alpha characters but also 
applies to the following character sequences in either forward or reverse sequence:

 #$%& 

 *+ 

 <=> 
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 ?@ 

 There must be at least one of the following special characters; $ % ^ & * + = @ # < > ?

3. Enter your new password again in the Confirm Password text field. 
 

3.1.2 Select a Prompt 
1. To choose a prompt, select a prompt from the drop-down list of prompts, and then 
enter the prompt answer. The answer to your chosen prompt must be unequivocal. 

2. Alternatively type in Your Preferred Prompt, and then type in the Prompt Answer. 

3. Click on the Change Password & Prompt link, or press <ENTER> to save the 
changes. 

When all changes are correct, and finally saved, the Web Interface opens with the 
current message of the day page displayed as illustrated in Fig. 3.4. 

Fig. 3.4 also shows a typical navigation menu from which the user can access all available 
administration facilities provided by RIDE Web interface (for further details see paragraph 
"The Navigation Menu"). 

Fig. 3.4 Message of the day Page 
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3.2 Subsequent Logins and Login Restrictions 
At the Web Interface your account login screen (Fig. 3.1) enter your User ID and 
Password. 

1. Click Login, or press <ENTER> to initiate the login sequence. The Warning page 
is displayed. 

2. Click Yes to complete the login, or click No to cancel. 

3. After clicking Yes, the Web Interface opens with the current message of the day 
displayed and the navigation menu (see Fig. 3.4). 

 

3.2.1 Login Restrictions 
A System Administrator can place login restrictions on users as follows: 

 The System Administrator can immediately log any user out of the system.

 The System Administrator can prevent further logins by an individual user.

 Login will be inhibited after three attempts at logging in with incorrect passwords. Login 
is re-enabled after a period of time defined by the System Administrator.

User accounts will be permanently disabled on reaching a pre-defined number of 
successive failed login attempts. 

If you have problems logging in, contact your Administrator. 
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3.3 Forgotten Password 
If you have forgotten your password, carry out the following: 

1. At the Web Interface opening screen (Fig. 3.1) click Forgot password? The 

forgotten password? page is displayed. 
 

Fig. 3.5 Forgot password page one 

2. At the forgotten password? page, enter your User ID and click Continue. 

3. You will be sent an email containing a Forgot Password URL, and the forgot 

password continued page is displayed. 
 

Fig. 3.6 Forgot password Email Confirmation 

4. Click Exit on the forgot password continued page. The your account login 

age is displayed. Close the your account login page as well. 

5. Open the email, ensuring that the complete URL is displayed in a single line as a 
link, and click on the URL link. 

The URL should appear in the Web Interface your account login page address 
field, if this is not the case, copy the complete URL into the address field and press 
<ENTER>. 

6. A screen similar to that shown in Fig. 3.5 will be displayed. Enter your User ID and 
click Continue. 

 

On entering the correct User ID, the screen changes to display your chosen prompt 
question, as shown in Fig. 3.7. 
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Fig. 3.7 Forgot password continued… 

7. Enter the answer to your prompt question, and click Next. Providing your answer 
matches the one stored on the user database against your ID, you will be invited to create 

a new password and prompt via the forgot password continued page (Fig. 3.8). 
 

Fig. 3.8 Final Forgot password continuation page 

8. To proceed, you must complete the mandatory (*) fields. The password must be 
new and not one that you have used before, but your prompt question and answer can be 
your current ones. For password rules, see: "Logging in for the First Time". 

9. Click Next to close the forgotten password? page and allow the login to proceed 
as normal. The appropriate Warning page (similar to Fig. 3.2) is displayed. 

10. Click Yes to complete the login. The Web Interface opens with the current 

message of the day displayed and the navigation menu (see Fig. 3.4). 

3.4 Logging Out 
Selecting Logout from the navigation menu will exit the user from the system, and close 
any open windows. 

As the current window closes, the screen refreshes, to leave the user back at the your 

account login screen, (shown in Fig. 3.1). Close the application by clicking the usual 

Windows Exit icon on the high level tool bar. 
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3.5 Time Out 
The system has an automatic time out feature that will, after a defined period of inactivity, 
lock the current screen. Upon the user attempting to access the screen again, the system 

will return the user to the your account login screen shown in Fig. 3.1. 

3.5.1 Session terminated message 
This indicates that the Web Interface has timed out, which means your session was ended 
after 30 minutes of inactivity. This helps to protect you against unauthorised access. 
Please ensure you have logged off properly at the end of every session by using the log 
off option on the left-hand tool bar. 

However, if this is not the case and you still experience this problem, it may help if you 
clear the cache on your browser and then try logging in again. Instructions for clearing 
your cache: 

 IE Browsers: Go to Tools > Internet Options...> and in Temporary Internet files, click on 
Delete Files and click OK.

 Netscape Browsers: Go to Edit > Preferences...at the bottom of the category window 
click on >Advanced> then Cache. Then open the Cache window option:- Click on 
Clear Memory Cache and then click OK, and the Clear Disk Cache and click OK.

 

3.6 System Security 
Apart from the password protection and the time out mechanism that inhibit non-privileged 
users from accessing the system (as detailed in previous sections of this manual), the 
system also runs an automatic password update routine. After 30 days the current 
password becomes void and a new password is prompted for by means of the change 

password screen shown in Fig. 3.3. Follow the step-by-step procedures detailed in 

"Change Password" to change the entry password. 
 

3.6.1 User Security obligations 
The security restrictions imposed by the platform to ensure only the correct people gain 
access to the system and the information it contains. All users have a role to play in 
maintaining this security and must adopt sensible precautions, which will include: 

 Never share or disclose passwords

 RUD is provided with only one service ID and PIN, so these must be shared if multiple 
users require access. But do not extend access to those who have no legitimate use of 
RUD.

 If you suspect anyone has learned your password, then change it.

 If a RUD user changes role or leave the company, change the RUD password PIN.

 If a web user changes role or leave the company, delete their user ID’s.
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4 USER INTERFACE CONVENTIONS 

4.1 General 
The Web Interface is accessed via an Internet Browser such as Microsoft Internet Explorer 
or Netscape (see "Introduction to the RIDE Platform Interface" for supporting versions 
of the permitted web browsers), and employs many of the standard features provided by 
these browsers. 

After login to the Web Interface, access to all available facilities for service administration 
and management is gained via the Navigation Menu. 

The Web Interface operates in a single browser window. 

The user can interact with the web interface by using both the mouse and the keyboard. 
 

4.2 The Navigation Menu 
The Navigation Menu is situated on the far left-hand side of the 
browser window. 

Items from the menu that can be selected for activation are 
highlighted as the mouse is passed over the item, and are then 
selected by clicking the left mouse button. Highlighting is 
shown as a lighter background behind the item. 

Allowing the mouse cursor to hover over an item will display a 
relevant tool tip. 

Users can select a menu item by clicking on the highlighted 
item once with the left mouse-button. 

Some menu items (i.e. MY ACCOUNT, USER 
ADMINISTRATION, and REPORTS AND GRAPHS) are 

headings, and clicking any of these items will open a submenu with additional items. An 
item that has been selected, from a sub menu, will be displayed in bold text, and remain 
displayed in this way until a different item is selected. 

Example: 

Heading: My Account 
Selected menu item: Details 
Additional menu item: Change Password 
Additional menu item: Change Prompt 

When selecting another menu item, the open sub menu will close. 
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4.2.1 Menu Items 
The RIDE Web Interface provides the following menu Items: 

 

Main Menu Items 

Message of the Day Displays the appropriate message of the day to all users. 

This is detailed in "Message of the Day". 

My Account This includes user Details, a Change password facility, 
and a Change prompt facility (used to establish user 
identity when they have forgotten their password). This is 
detailed in “My Account” 

User Administration Contains details of all existing Service Provider Users and 
provides facilities to administer new users. 

Note: This option is available to Service Provider 
Administrators only. 

This is detailed in “User Administration”. 

Service Provider Allows the user to view and/or modify the Service Provider 
details. This is detailed in “Service Provider”. 

Service Administration Lists all services, and provides access to facilities for 
viewing a service, and for modifying a service. This is 
detailed in “Service Administration”. 

Reports and Graphs Provide a means of viewing an analysis of service-specific 
call data and platform wide statistics, in a variety of formats. 
This is detailed in “Reports and Graphs”. 

Talk to Us Provides the user with a utility to send feedback or support 
requests to the platform provider. This is detailed in “Talk 
To Us” 

Help Provides a link to the Help files. This is detailed in “Help” 

Logout Ends the current user logon by initiating an immediate 
logout. This is detailed in section “Logging Out” 
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4.3 Command Links 

4.3.1 Text Links 
Appropriate command links are provided on individual Web Interface pages to provide 
access to other pages, or to perform some sort of action suggested by the link name. The 
link names are displayed in coloured text, and are usually provided both at the top and 
bottom of the page on grey link bars. 

Positioning the mouse cursor over a link causes the cursor to change to a pointing finger. 
With the finger shown, click with the left mouse-button. Links can also be selected by 
highlighting the link using <TAB>, and then pressing <ENTER>. 

The links are operated as follows: 

 

This link saves any changes that have been made to the current 
page, and is usually found in forms. 

This link performs an undo action for any unsaved changes to 
the current page. 

This link takes the user to the last page visited. 

This link is used to refresh all data on the screen being viewed 
by the user. This is a one-time event, which is processed 
immediately. This link is also used to refresh all data on the 
screen. 

This event will be processed around every thirty seconds until 
the auto-refresh is interrupted. 

Clicking this link will halt the auto-refresh. 

This link is used to print the current page. By default, the 
navigation menu is not printed. 
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4.3.2 Icon Links 
Icon links are provided in pages displaying lists or tables to link to another page. The 
column name in the table gives an indication as to the content/purpose of the link. 

Icon links are operated by clicking on the link with the left mouse-button. The links can 
also be selected by highlighting the link using <TAB>, and then pressing <ENTER>. 

View opens a page where the user can view details for a specific variable, 
service, etc. 

Modify opens a page displaying the details ready for modification for a specific 
variable, service, etc. 

Announcement defines that the value is an announcement. The announcement 
can be played by clicking the icon. 

Help on a page is a link to the context sensitive Help relevant to the page. 

Calendar opens the Calendar dialogue. The Calendar controls are used to set 
the time and date. 

Login Status indicates whether the user is allowed to log in, or not. Clicking a 
green Key opens the disable login window (see “Set Login Status for a 
Service Provider User" ). Clicking a red Key link resets the Login Status to 
Enabled. 

Example of icon links, and their operation: 

This icon link will take the user to a page 
where they can modify the User 
‘DNGJ000001’. 
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4.4 Announcement Playback 
Announcements are represented by the Announcement  icon, and they may be 

accessed by clicking on the icon. This will open the announcement play screen, as 
illustrated in Fig. 4.1, which may look different depending on your default media player. 
The announcement selected will automatically play, however, in the event that it does not, 
refer to “Announcement Playback Troubleshooting”. 

 

Fig. 4.1 Announcement - Play 

The user may stop the announcement playback at any point by clicking on the stop button. 
Once the announcement playback has completed, the user may play the announcement 
again by clicking on the play button. The user can close the window when finished 
listening. 

If the media player does not present any Play and Stop buttons (e.g. Windows Media 
Player 9.0), right-click in the window and use the Play and Stop options from the popup. 

 

4.4.1 Announcement Playback Troubleshooting 
There are a couple of known reasons why an announcement can not be played within the 
RIDE Web Interface. These, and the appropriate solutions, are described below. 
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4.4.1.1 Announcement does not Playback Automatically 

If your announcement does not playback automatically: 

Click here at the end of the hyper-link message: 
If you have any problem listening to the announcement click here. 

This message appears immediately below the player control buttons, as illustrated in Fig. 
4.2 

Fig. 4.2 Announcement playback problem 

Windows Media Player will launch. If the announcement does not play automatically click 
Play on the control bar. 

 

4.4.1.2 Announcement Playback on a Secure Server 

Microsoft have issued the following notice when using Media Player on a secure server: 

“You receive a ‘A security problem occurred’ error message when you try to play content 
on a secure Web site in Windows Media Player 9 & 10”. 

Symptoms 

As illustrated in Fig. 4.3, when you try to play content that is located on a secure server 
(https://) in Microsoft Windows Media Player 9 & 10, you receive the following error 
message: 

Fig. 4.3 Security problem 

If you click Close, the content does not play. If you click Web Help, you receive an error 
message that refers to 800C000E. However, you cannot find any help for this error 
message. 

Solution 

To resolve this issue, save the content to your local computer before you try to play it. To 
do this: 

1. As illustrated in Fig. 4.4, right-click the here hyper-link on the announcement play 
screen, and then click Save Target As... from the pop-up menu. 
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Fig. 4.4 Announcement - Save to local computer 

2. The Save As dialogue, illustrated in Fig. 4.5 is displayed. Select a directory to save 
the announcement file in. 

Fig. 4.5 Save As dialogue box 

3. Open Media Player (Start > Programs > Windows Media Player) and play the 
announcement from your PC. Once you have listened to the announcement you may 
return to the Web Interface, but bear in mind that any other announcements you wish to 
play will encounter the same problem. To avoid this inconvenience carry out the 
procedures outlined in “Windows Media Player Wav File Disassociation”. 

4.4.1.3 Windows Media Player Wav File Disassociation 

It is likely that your Media Player settings have been configured to be associated with all 
file types, including .wav files. As this is the case Media Player will be designated as the 
default player for .wav file and subsequently all announcements used by the RIDE system. 

As Media Player cannot play .wav files from a secure server you will always encounter 
the the security problem message illustrated in Fig. 4.3 when you attempt to play an 
announcement. 

You can, however, disassociate .wav files from Media Player and prevent this message 
from re-appearing. To do this: 

1. Open Media Player (Start > Programs > Windows Media Player) and select 
Tools > Options from the tool bar menu at the top of the application. The Options 
dialogue is displayed. 

2. Select the File Type tab, as illustrated at Fig. 4.6 
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Fig. 4.6 Media Player Option dialogue 

3. Uncheck the box labelled Windows audio file (wav). 

4. Click OK and close the Media Player application. 

5. Reboot your computer. 

Once you have disassociated .wav files from Media Player it is no longer the default 
player for system announcements. The next time you try to play an announcement from 
the Web Interface, you will still have the problem in that the announcement will not be 
played automatically. 

However, when here is clicked this time, the Sound Recorder application, illustrated in 
Fig. 4.7, is launched. To play the announcement, click Play on the control bar. 

Fig. 4.7 Sound Recorder application 
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4.5 Data Entry Fields 

Alphanumeric data can be entered into Data Entry fields (text fields) to update a value 
attached to a label. In the example above, the Service Name will be updated to equal 
Eurovision Televote. 

Access to a data entry field is by use of the mouse, or <TAB>. Data can then be entered 
into the field as necessary. Data in the field can be deleted and edited as required. There 
will be a maximum number of characters in the field. When data input is complete, click 
Save. 

Note: Where there are a number of associated data entry fields, use <TAB> to move to 
subsequent fields. 

 

4.5.1 Drop Down Lists 
A drop-down list displays a list of items that users can select. 

Drop-down lists are accessed by clicking the down arrow at the end of the 
field. One item is displayed on each line of the list, and one item can be 
selected from the list. 

List items can be selected by using the up and down keyboard cursor keys, 
or the mouse, and then pressing <ENTER>. 

 

4.5.2 Check boxes 
A checkbox is a control that operates as a toggle, used to 
select one or more options from a fixed list. An empty 
checkbox means the item is not selected; a ticked box 
means the item is selected. 

Pressing the keyboard space bar can toggle checkbox 
selections. 

 

4.5.3 Radio Buttons 
 
 

Radio buttons are used to select a single option from a group of options. 

Selecting one radio button will de-select any other. 

The left and right keyboard cursor keys can be used to navigate from one radio button to 
another. 
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4.5.4 Dialogue Boxes 
Dialogue boxes are used to provide the user with information. Dialogue box command 
buttons can be pressed by using a single left mouse-button click, or by highlighting the 
button using the <TAB> key and then pressing <ENTER>. 

The dialogue box can ask for confirmation of any action before 
the user may proceed. 

The user must select OK before the requested action can be 
carried out. 

Selecting Cancel will disregard the requested action. 

Dialogue boxes can also provide some brief information 
of a user error. 

You must first carry out the dialogue box action before 
you may proceed. 

 
 

 
4.5.5 Paged Lists 
For drop-down lists that have more than 50 items, the list may extend over more than one 
page. 

The paging bar is used to navigate between pages. 

Returns the user to page one. 

Takes the user back one page. 

Takes the user forward one page. 

Takes the user to the last page available. 

The user can also jump to a specific page by selecting a page 
from the drop-down list. 
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4.5.6 The Search Box 

On Web Interface pages where the user may need to locate data for a specific user, 
service provider, service, or service variable from many pages of listed data, a search 
facility is provided. 

             The type of search provided will be appropriate for the data presented, and it will be limited 
to a particular column of the data displayed. In the example search box shown above, the 
search will be for a specific user. 

The search facility is operated by entering a character string into the search field and 

clicking   . 

On completion of the search, only the data relating to the individual service names (user 
names, SP names, or variables) that match the search string will be returned to the 
display. 

 

Note: If the search string is not specific, the data presented may still spread over more 
than one page. 

Attaching an asterisk (*) to the right-hand side of a word will return left side partial 
matches. Similarly, attaching an asterisk (*) to the left-hand side of a word will return right 
side partial matches. 

Clicking   causes the search to be reset and all data items in the list to return to the 
display. 



Ride Web Interface Service Provider User Guide 

Issue A3i 08 August 2019.  

Copyright © BT 

 

….. 

 
 

4.5.7 The Date and Time Calendar Dialogue Control 

Time and date variables are adjusted via the Calendar dialogue control, which is 
accessed by to clicking next to the date field. 

Calendar Dialogue 

1. Set Month and Year using the drop-down lists, or 
the paging controls as follows: 

Back one year 

Back one month 

Forward one month. 

 
Forward one year 

2. Set the date by clicking the date grid as 
appropriate. 

3. Set the time using the Hrs, Mins, and Secs drop- 
down lists. 

 
 

Now. This will set the current system date 
and time in the Calendar window. 

Never This sets the date to 23:59:59 31-Dec-2037 

OK Once the month, year, day and time has been selected the user must 
click the OK link to accept the date field 

 

 
4.5.8 Sorting of Real Time Statistics 

In Real Time Statistics screen views, data columns which include the Sort icons  and  

, can be used to sort the statistics being presented. Clicking the Sort icon will numerically 
or alphabetically arrange the order of data in the column and represent the statistics, DDIs 
are arranged in ascending order, call counts are arranged in descending order. The 
column used for the current Primary sort is indicated by an orange Sort icon and the 
column used for Secondary sort is indicated by a blue Sort icon 
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4.6 Printing 
To print the details as displayed on any screen, click on the Print link to open the Print 
dialogue box, an example of which is shown in Fig. 4.8 

Note: The RIDE Web Interface screens have been designed to enable printing of the 
information on to A4 Portrait pages. 

To Print the current screen display: 

1. If the system has a number of 
network connected printers, select 
the required printer. 

2. Click on the Preferences 
button and set up the printer to 
produce the required output in terms 
of paper selection, orientation etc. 

3. Set the Page range to l, and 
set the number of copies as 
required. 

4. In the Print frames options, 
under the Options tab, select Only 
the selected frame. 

5. Click the OK button to start 
the print. 

Fig. 4.8 Print Command Dialogue 

 

4.7 Help 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Box 

Selecting the Help menu displays a menu option sensitive help file. The text used for the 
help files is generally taken from this manual and used to produce an on-screen context 
sensitive help file. 

The icon on a page is a link to the context sensitive Help relevant to the page. 
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5 MESSAGE OF THE DAY 

message of the day is a message that is displayed on the opening page of the Web 

Interface after a user logs in, and will be displayed for users at all levels of access. 

The message of the day can also be accessed from any Web Interface page by clicking 

MESSAGE OF THE DAY on the navigation menu. 
 

Fig. 5.1 Message of the Day - Opening Screen 
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6 MY ACCOUNT 

6.1 My Account – Details 
Users can view and/or change their details by clicking on the 
MY ACCOUNT > Details option of the Navigation Menu, to 

open the account detail page. 
 

 

Fig. 6.1 My Account - Details 

The various fields in the account detail page allow the individual user to update their 

personal details, and then to save these changes by clicking Save before exiting the 
screen. Clicking Cancel will undo any unsaved changes. 

The three personal fields marked with an asterisk (*) are mandatory, and must not be left 
blank. 

The User ID field and the Language field are “read only”, as the data that they contain 
formed part of the original configuration set up, entered when this particular user was first 
added to the system. Refer to “Add New User”, as an example. 

A list of all the parameters that appear on the Account Detail screen along with a brief 
description can be found in Table 6.1. 
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Account Detail parameters 

  Parameter Name Description  

User ID A read only identifier, entered by the administrator at the time of 

the original entry of this user onto the system. The user ID is used 
by the system, in conjunction with the password and the name 
entries to identify the logged in user, and to allow the system to 
establish the relevant privileges that are afforded to the user. 

* First Name The first name of the logged in user. 

* Surname The surname of the logged in user. 

Language This is set for English, although originally the option was chosen 
from a drop down menu. 

Last connected Displays the date and time details when this connection was last 
invoked. 

Password last 
changed 

Displays the date and time details of when the current password 
was last changed by the logged in user. 

* Email The email address of the logged in user. 

Table 6.1 Account Detail screen parameters 

6.2 My Account - Change Password 
The user can change their password by clicking on the MY 
ACCOUNT > Change Password option to open the change 
password screen, shown in Fig. 3.3. Refer to "Change 
Password" for password details. 

 

6.3 My Account - Change Prompt 
In addition to the User ID and Password prompts that are included as part of the in-built 
security for the network, a prompt is included to help users who forget their password(s). 
This prompt offers a chance to users who have forgotten their password, to identify 
themselves by giving the accurate prompt answer in order to receive a new password from 
the system. 

The user can change the prompt by clicking on the MY 
ACCOUNT > Change Prompt option. This opens the window 
shown in Fig. 3.3, with the old prompt displayed. Refer to 

Change Password for password details. 
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7 USER ACCOUNT TYPES 

There are two types of Service Provider user account, with differing levels of control over 
the Recorded Information Distribution Equipment (RIDE) platform. The user types are 
listed below with details of their function. 

 

7.1 Service Provider Administrator (SPA) 
The Service Provider Administrator is the highest level of user available to a Service 
Provider. Each service is provided with a single SPA account. This SPA account allows 
you to create other user accounts and set their privileges. The SP User accounts can 
have all the privileges of the SPA – except for the ability to create and administer other 
users. 

Functions available to the SPA include: 

 View and maintain services.

 Administer and maintain Service Provider Users.

 View service reports and graphs.

 Maintain own user account details.

 Maintain Service Provider User account details.

User accounts of this type are subject to the same login restrictions (and procedures) as 
any other. 

 

7.2 Service Provider Users (SPU) 
The Service Provider User is identical to the SPA account with the exception that they may 
not create any further user accounts. The Service Provider Administrator may assign a 
different set of privileges to each user they create. 

Functions available to the SPU include: 

 View and maintain services.

 View service reports and graphs.

 Maintain own user account details.

User accounts of this type are subject to the same login restrictions (and procedures) as 
any other. Users of any other account-type can set privileges for this user. 

The number of accounts is limited to twenty five for any one Service Provider. 
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8 USER ADMINISTRATION 

8.1 Introduction 
User Administration contains details of all Users for the Service Provider. The main 
features of User Administration by the Service Provider include: 

 The addition of a user or users to the active system.

 Allowing details of an existing user to be modified or updated.

 The removal of an existing user or users from the system.

 The restoration (or reinstatement) of a previously deleted user.

 Account maintenance of existing users.

 Viewing the login status of user accounts.

 The password reset facility.

 The failed login attempts counter.

 Configuration of user permissions.

 Configuration of user groups.

8.1.1 User access 
Any user must only be provided with access to those aspects of any service that are 
required for the execution of their work tasks. 

For any given service, there are tasks which a number of people might undertake. In the 
majority of cases this segregation of access is the same across many services. Rather 
than define every user’s permissions on a user by user basis, users may be included in 
groups, where they all have the common requirements. Some users are provided with 
access to multiple groups. Therefore: 

 Each user only requires a single ID and password combination to log on.

 A user may be assigned to one or more groups.

 Each user may have its privileges varied against the Default Service Provider User 

Group via the User Add or User Modify pages.

 Each user may be provided with permission to allow or deny access one or more 

securable object via the User privileges page. E.g. it may be used to bar access to 

one or more or all Reports.
 

8.1.1.1 Securable objects 

A securable object can be defined as a ‘designated area of responsibility’ that is granted to 
a user which allows them to perform their administrative duties in a controlled manner. 

The designated areas are: 

 Product Type
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 Reports

 Real time statistics

 Service

 Users and

 User groups.

8.1.2 User groups 
To simplify the allocation of access rights, users with identical requirements can be 
assigned to a single User Group. Each group is provided with permission to allow or deny 
access one or more securable objects. 

 

8.1.3 Select your access control strategy 
The User Administration provides a great deal of flexibility in defining how you can 
control access to all aspects of your services. This flexibility comes at a cost of 
increased complexity. You are advised to 

 Keep your strategy as simple as possible to meet your requirements. This avoids 
confusion.

 Do not grant access to Securable Objects from both Users and User Groups. It can 
be very confusing and it does slow the screen response times. Every time you make a 
screen selection, the system has to check your User and Group permissions before it 
builds the new screen.

 The best option is to add all the necessary privileges to the User Add page for each 

User (i.e. those suggested in Add a new User and Default User Group -Set user 

privileges). This means every User Add or User Modify page will look the same. If 

you do not need to restrict any access, this is all you need to do.

 If users need only to access certain Securable Objects, create a group to remove or 
restrict all other access. This has the advantage that you can move users to different 
roles by just changing their user groups – you don’t need to remember how the 
predecessor had been set up. It is also advisable to always have more than one 
person with permission to perform a task – in case of emergencies, sickness, holidays 
etc.
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8.2 The User account 
Clicking on USER ADMINISTRATION > Maintain Users in 

the navigation menu opens the user administration 
screen as illustrated in Fig. 8.1, with a list of active users 
displayed. Initially, there will be no users listed. You have 
to add them. Where users have been provided, the list is 

sorted alphabetically, primarily by user name. 

Fig. 8.1 User administration Screen 

A brief description of the user administration page fields is provided in Table 8.1. 
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User Administration page fields 

Search User Initiates a search for a specified user. This search is based on 
the user name (or part of the name) which is typed into the 
Search User text field.  Clicking   starts the search, and 
clicking    clears the search criteria (see "Search for a Service 
Provider User"). 

Select This check box is used in conjunction with the Delete, Restore 
and Reset Password commands. See Table 4.2. 

User Name This column provides read only display of Surname and First 
Name of all active users. 

User ID This column provides read only display of the User ID, which 
must be between 6 and 10 ASCII characters long. 

Failed Logins This column displays the number of failed login attempts this 
user has made since the last successful login. This figure will 
remain in the table until the user has successfully logged in. 3 
consecutive failures, the user is temporarily locked for 5 minutes. 
Further failed are logged until the counter reaches 99, when the 
access is permanently locked out. This requires Administrator 
action to re-enable the user access. 

Modify 
 

 

Click on this icon to modify a User’s account details (see "Modify 
User Details"). 

Privileges Clicking displays the user privileges page (see ‘Granting 
User Privileges’. 

Change Password Allows the selected users password to be changed manually to a 
one-time-only password. 

Enable/Disable 
Login 

 

 

The green Status represents an active/enabled Login account 
for the user. A red Status icon link Shows that the user account 
is currently locked. This user will not be able log in to the system 
(see “Enable/Disable Login for a User"). 

Add Adds a new user to the system (see “Add a New User"). 

Delete Deletes a SPU from the system (see “Delete a User"). 

Archive Used to display previously deleted users. 

Restore Used to restore users previously deleted users from the archive. 

Reset password Emails a new, automatically generated one-time-only password 
to any -selected User (see "Reset Password for a User"). 

Cancel Cancels the current selection in the Select column. 

Table 8.1 User functions 
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8.2.1 Add a new user 

1. From the user administration page illustrated in Fig. 8.1, click Add to open the 

user add window illustrated in Fig. 8.2. 
 

 

Fig. 8.2 Add New User - Details Entry 

The system automatically generates a random User ID for the new User, but this can be 
over-written. 

2. Complete the text fields, entering the appropriate details as necessary. 

Make sure all the mandatory fields (marked with the red asterisk *) are completed 
otherwise the system will not allow the user details to be saved. Failure to enter a 
mandatory field will force the system to prompt for the missing details. 

The User Type defaults to User and can not be changed. 

Note: The entry fields are case sensitive. 

3. English is the only Language currently available from the drop-down list. 

4. Take care to enter the correct email address. 
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8.2.1.1 Set User privileges against the Default SP user group 

Leaving all these privileges unchecked reveals the following Navigation Menu items to the 
User: 

 Message of the day

 My Account

 Service Provider

 Talk to us

 Help

 Logout.

The impact of checking each privilege is described below: 
 

Privilege Description 

Maintain SPU This field should not be checked. Leaving it blank 
removes the User Administration option from the 
Navigation menu. If it is checked, menu item appears 
and may be selected, but there is nothing within this option 
for the user to see or use. Leave it un checked. 

Maintain Service Variables This reveals the Service Administration entry in the 
Navigation menu. It allows the User to set up and 
maintain values for all the service variables and to view 
any future activation or deactivation events for their 
services. 

Maintain Services This reveals the Service Administration entry in the 
Navigation menu. It allows the User to view all services 
and their service variables and to view any future activation 
or deactivation events for their services. 

View Statistics This reveals the Service Administration and Reports 
and Graphs entries in the Navigation menu. It allows the 
User to 

 view all the services 

 view the service variables ( no changes allowed). 

 view real time statistics and 

 run all reports 

Maintain Announcements This reveals the Service Administration entry in the 
Navigation menu. It allows the User to view all service 
variables but only to change service announcements and 
to view any future activation or deactivation events for their 
services. 

Table 8.2 Add user privileges 
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Fig 8.3. Main Navigation Menu. 

5. Set the User Privileges for the USER by ticking the check boxes to select/de-select 
the privileges described in Table 8.2. 

6. When all details for the USER are complete, click Save to add the new user. 
Alternatively: 

 Clicking Cancel will remove all entered details and reset the default values where 
appropriate.

 Clicking Back will return the display to the user administration screen shown in
Fig. 8.1. 

7. Before the new user is added, a dialogue box in Fig. 8.4 opens requiring 
confirmation that you want to add the new user. 

 

Click OK to confirm and complete the addition. 

Clicking Cancel aborts the addition process. 

Fig. 8.4 Add New User Confirmation Dialogue 

 

8. If the system detects a duplicate User ID, it declines the entry and continues to 

display the user add window, illustrated in Fig. 8.2, with the duplicate entry still shown, 

but now with the added warning: User already exists. 

9. If you decide to abort the duplicate entry, click Cancel to clear the data and reset 
the privileges to their default values. 
Alternatively, enter a unique User ID, and click Save to save the details. If the system 
accepts an entry, the display shows a successful entry to the system, by displaying the 
screen shown in Fig. 8.5. 
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Fig. 8.5 New User Added 

To add another new USER to the system, click on Add New to open the user add 
window illustrated in Fig. 8.2. Clicking OK returns you to the user administration 
screen as in Fig. 8.1. 

 

8.2.2 Modify user details 

1. To modify the details for a particular user, display the user administration 
screen illustrated in Fig. 8.1, and click in the Modify column for that user. The current 

details for the named User will be displayed in the user modify screen, as illustrated in 

Fig. 8.6. 

Fig. 8.6 Modify Service Provider User Account screen 

2. Modify the data in the data entry fields as required. 

3. Change User Privileges as required (refer to “Add a New User” for details of user 
privileges) 

4. Click Save to save the changes. 
Clicking Cancel (before saving) will clear all the changes and reinstate the original user 
details. 
Click Back to return to the previous screen without committing any changes. 

The Access Control takes you to the user security Tabbed pages. See Modifying 

access control. 
 

8.2.3 Granting user privileges against securable objects. 

Note: You are advised not to use these screens to control privileges against users, but to 
use the facilities available under User Groups. 

This is advised for two reasons: 
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 Mixing the use of User and User Group permissions will slow the screen refresh speed 
as all the permissions must first be checked and

 Mixing the use of User and User Group permissions can be confusing. Make life 
simple by creating suitable groups and then make your Users members as required.

 

From the user administration screen illustrated in see Fig. 8.1, select the privileges 

icon in the row against the appropriate User Name. The User Privileges screen is now 

displayed, see Fig. 8.7. 

Fig. 8.7 User Privileges screen, User group membership tab. 

The user privileges screen consists of three tabbed pages and always defaults to the 
User Group Membership tab. 
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8.2.3.1 User Group Membership tab 

The User Group Membership tab is used to provide the selected user with membership 
of one or more User Groups. It has the same effect as the adding members to a selected 
User Group, described below in Assigning individual users to User Groups. 

1.. Click Add. The page changes to show the User Groups which are available. 

Table 8.8. User privileges - join a User to a User Group 

2. Use the check box in the Select column to select the required user group. Click Join. 

 

3..The dialogue box requests confirmation that you wish to join 
the user .to the selected user group. Click OK. 

 
 

 
Fig 8.9 Join User Group dialogue box. 

The page then displays: User has been successfully added to selected User Group. 

Fig. 8.10 User Join confirmation 
 

8.2.3.2 Access Control Entries tab 

Note: You are advised not to use these screens to control privileges against users, but to 
use the facilities available under User Groups. 

Selecting the Access Control Entries tab causes the page to update as shown in Fig. 8.11. 
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Fig. 8.11. User privileges, Access Control Entries tab. 

The Access Control Entries tab is used to control the privileges of the individual User. 

See Granting Access to Securable Objects within User Groups. In this example we 
will prevent access to Real Time Stats. 

1. Select the Securable Object Type list box. 

2. Select Real Time Statistics. 

3. Click Add. This defaults to ALL (Default) and Hidden. Leave these options as they 
are. 

4. Click Save. The page updates as shown in Fig. 8.12 

Fig. 8.12 Updated Access Control Entities page. 
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8.2.3.3 Summary tab 

Selecting the Summary tab causes the page to be updated as shown in Fig. 8.13 

Fig. 8.13 User Privileges, Summary tab 

The summary screen shows that: 

 All Real Time Statistics are Hidden from this User.

 The Statistics User Group has Hidden the FIVA filtered SDR data dump report from 
this the user group.

These Default groups are all required to set the initial configuration and should be ignored. 
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8.2.4 Search for a User 
To search for a specific user, or users, and display only their records on the user 

administration screen, use the Search User facility as follows: 

1. Enter the user name, or the first part of the name, as a search string in the Search 
User text field. 

 

2. Click , or press <ENTER>, to start the search. 

If the search is successful and matches the search string entered, the display will show all 
matching record(s). The appropriate administration procedures can be carried out. 

If the search is unsuccessful, the display will show the statement: 
Sorry, no records found 

The search should be restarted as follows: 

3. Click    to clear the search string from the Search User data entry field, and 
return to the display of all User records. 

4. Return to step 1 above and repeat the procedure, this time entering a different 
search string. Bear in mind the rules governing search criteria. 

The only characters that can be used in the search text box are: (A-Z) (a-z) (0-9) and (*). 

If only part of the name is known, the (*) character can be used as a wild card. For 
example; entering all* will return all matches starting with all. Similarly, entering *all will 
return all matches ending with all. 

 

8.2.5 Delete a User 

1. From the user administration screen illustrated in see Fig. 8.1, select the User 

to be deleted by clicking in the Select checkbox next to the User Name. 

Note: Multiple selections are possible by marking other Users as required. 

2. When the selection is complete, click Delete. The confirmation dialogue box in Fig. 
8.11 is displayed. 

 

Click OK to delete the selected user(s). 
Alternatively, click Cancel to abort the deletion 
process. 

 

Fig. 8.11 Delete warning 

 

The user administration screen refreshes to include the message shown in Fig. 8.12 
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Fig. 8.12 user administration screen extract, following a deletion. 

If no selection is made before Delete is clicked, the 
system displays the prompt shown in Fig. 8.13. 

 
 
 

 
Fig. 8.13 Selection Process Incomplete 

Ensure that the unwanted user has been selected by ticking the check box on the User list. 

Deleted accounts are archived on the system, usually for 60 days, however, this time 
period is configurable. Once this time period has elapsed the system will automatically 
remove the accounts. 

At any time during the archive period an account may be restored. See “Restore a 
Deleted User” for details on restoring an archived user. 
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8.2.6 Restore a Deleted User 

1. From the user administration main screen illustrated in see Fig. 8.1, click 

Archive. 

The user restore screen in is displayed. All Users who have been deleted during 

the configurable archive time period are listed. These Users can be restored to the 
system. 

Fig. 8.14 Restore User Selection Screen 

2. To view the details of a deleted User before (before restoring), click in the Modify 
column in the same row as the User Name. 

The details are displayed on the account detail page. These details are read-only and 

can be printed from the page by clicking Print. Clicking Back on the account detail 
page returns you to the user restore page. 

3. Select the user (or users) to be restored by clicking the check box(es) in the Select 
column next to the User Name. 
Re-click on a ticked checkbox to clear a selection, or click Cancel to clear all the check 
boxes. 

4. When the selection is complete, click Restore. The dialogue box at Fig. 8.14 will 
ask you to confirm the restoration process. 

 

Fig. 8.14 Restore Confirmation Box 
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5. Click OK to continue the restoration process. The following message is displayed: 

Selected Record(s) has been restored successfully 

Alternatively, click Cancel to abort. 
 

8.2.7 Reset password for a user 

1. From the user administration screen illustrated in Fig. 8.1, select the required 

user(s) that is/are to have their passwords changed. 

2. Click Change Password. You will be prompted to confirm your wish to change the 
user’s password. 

3. The user will be sent a new automatically generated password. This new password 
allows one-time-only access to the system and the user will be prompted to change their 
password after a successful login. 

 

8.2.8 Change password for a user 

1. From the user administration screen illustrated in Fig. 8.1, select the required 

user(s) that is/are to have their passwords changed. 

2. When the new password and confirm password fields have been completed, click 

Save. The user administration screen continues to be displayed, but now includes the 

message: 
Password successfully changed 

3. The user needs then to be told of the changed password. This new password allows 
one-time-only access to the system and the user will be prompted to change their 
password after a successful login. 

 

8.2.9 Enable/disable login for a user 
The login status is indicated by a green  or a red    key symbol. 

To lock a User account: 

1. From the user administrator main screen illustrated in Fig. 8.1, click on the 

green Login Status key next to the User Name. 
 
 

The disable login screen illustrated in Fig. 8.14 is displayed. 

Fig. 8.14 Disable Login screen 
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2. Tick the desired radio button, either Prevent logging next time or Immediate 
logout from the system. 

3. Click Save to activate the new setting. 
Alternatively: 
Click Cancel (before saving) to clear all the changes and reinstate the original status. 
Click Back to return to the previous screen without committing any changes. 

To unlock a locked User account; 

1. Click the red Login Status key  next to the User Name. 

The following message is displayed: 

Selected User account has been successfully unlocked 

2. The Login Status key changes to green 
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8.3 User Groups 
All new users are not automatically added to any Service Provider User Group. In this 
state a new user can not see or do anything. You may add user groups to provide 
different levels of access. And then make the user a member of the required group or 
groups, gaining the permissions granted by each group. 

For example, it is possible to create one group which grants access to all service types, all 
services within those service types and all reports. The examples that follow show how 
such a group is provided – the group is called SPU open access. This is a common mode 
of operation and it is suggested that if you use such a group, you use the same name. 
This will help your account manager to understand the group, should you call for their 
assistance. 

Another example might be to create a group which only provides access to a single 
service and its reports. This may be used where security of access is of paramount 
importance. 

 

8.3.1 Create user groups 
User Groups are added to the system from the user group administration page. 

 

8.3.1.1 User Group Administration Page 

To access the user group administration page: 

1. After successfully logging on to the RIDE Web Interface, click USER 
ADMINISTRATION from the main navigation menu in Fig. 8.15. 
Two sub menu items are displayed. 

>Maintain Users 

>Maintain User Groups 

2. Click >Maintain User Groups 

The user group administration page illustrated in Fig. 8.16 is 

displayed. The description of the fields displayed on the page is given 
in Table 8.3. The available commands are described in Table 8.4. 

Fig 8.15 Main navigation menu 
 

 

Fig. 8.16. User group administration page. 

As no user groups have yet been defined, No records found is displayed. 
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8.3.1.2 The user group Administration fields and commands 
 

User Group Administration Page Fields 

Field Description 

Select This check box is used in conjunction with the Copy, Delete 
and Restore commands. See Table 8.4. 

User Group Description This is the name given to the User Group e.g. Small 
Televote Provisioning Team. 

Members This column indicates the number of Individual Users that 
have membership of that User Group. 

View Clicking the magnifying glass icon allows you to view and 
modify the User Group details. 

Status This column indicates whether the User Group is enabled or 
disabled. 
A green disc indicates that the User Group is enabled. 
A red disc indicates that the User Group is disabled 

Table 8.3 User Group Administration page fields 
 

User Group Administration Page Commands 

Command Description 

Add Used to add a new User Group to the system 

Copy 
Used in conjunction with the Select column check box to make a copy of 
an existing User Group which will be saved with a different name. 

Delete Used in conjunction with the Select column check box to delete a User 
Group from the system 

Restore Used to restore a deleted User Group to the system 

Refresh Used to update the page after saving any modifications. 

Cancel Used to clear all checked check boxes in the Select column. 

Table 8.4 User Group Administration Page Commands 
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8.3.1.3 Adding a user group 

1. From the user group administration page illustrated in Fig. 8.16, click Add. The 

user group add page in Fig. 8.17 is displayed. 

Fig. 8.17 The user group add page 

2. In the Description field enter the designation for the User Group. This example will 
show how we create a user group which has access to all of your services services. It is 
anticipated that most users will operate this way and it is suggested that the group name is 
entered as SPU Open Access. 

3. In the Notes text field enter a brief description of the areas of responsibility for this 
Administrator User Group e.g. “This user group allows SPU’s to see all services.” 

4. Click the Enable this Group check box if you wish to enable the group with immediate 
effect. 

5. Click Save. The page updates showing the new User Group and, as illustrated in Fig. 
8.18, the following confirmation message is displayed: 

User group has successfully been added. 

The user group administration screen previously shown in Fig. 8.16 has now been 
updated as shown below in Fig. 8.18: 

 

 

Fig. 8.18 Saved user group. 
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8.3.2 User Group access to securable objects 
Now that the User Group has been created you now need to grant access respect to 
permit the required tasks to be performed. 

Areas of responsibility are applied to a User Group by means of assigning Securable 
Objects and their associated Permissions to the group; thereby determining that groups’ 
access rights to the system. 

 

8.3.2.1 Access level permissions 
 

Basic access level permissions for Securable Objects 

Level Description 
Securable objects 
applicable: 

 
 

 
Administrator 

 Administration of Services within their 
area of responsibility. 

 Create and administer User Groups. 

 Create and maintain Individual Users’ 
accounts. 

 Generate reports within their area of 
responsibility. 

 
 

 User 

 User Group 

 
 
 
 
User 

 Administration of Services within their 
own area of responsibility. 

 Create and administer User Groups 
within their own area of responsibility. 

 Create and maintain Individual Users 
within their own area of responsibility. 

 Generate reports within their area of 
responsibility. 

 

 Reports 

 Product type 

 User 

 User Group. 

 

Full Access 
Complete access to Real Time Stats 
including Reset and Freeze where it would 
normally be available to the service. 

 

 Real Time Stats 

 

User Service 
Type Definition 

The default setting for the Service Type, 
which may or may not include Reset and 
Freeze. This is the default setting for all 
users. 

 
 Real Time Stats 

Basic View only 
As for User Service Type Definition but 
without the By Call Type drop down list. 

 Real Time Stats 

 
View only 

 
The ability to see but not modify. Also 
known as read only access. 

 Product type 

 User 

 User Group. 
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Basic access level permissions for Securable Objects 

Level Description 
Securable objects 
applicable: 

 

 
List only 

 

Able only se the existence of items on a 
list, but not able to select the items. 

 Reports 

 Product type 

 User 

 User Group. 

 
 

Hidden 

 
 

Not shown on screen at all. 

 Reports 

 Real Time Stats 

 Product type 

 User 

 User Group. 

Table 8.5 Securable object access level permission 
 

 

Special access level permissions for Securable Objects 

Level Description 
Securable objects 
applicable: 

 
Provision 

The ability to add, add, delete, (copy, 
move, restore or delete where applicable) 
any number of Securable Objects that 
require provisioning 

 User 

 User Group 

 
 
 

 
Modify access 
control 

You are strongly advised not to use this 
facility. It will slow system response, adds 
complexity to the setting of permissions 
and may confuse you. This access level 
provides the ability to override the default 
access rights for Securable Objects that 
have been applied to User Groups and/or 
Individual Users and allows you to grant 
additional or fewer areas of access where 
required. For more information refer to 
‘Modifying Access Control’ 

 
 
 

 
 All securable objects. 

Table 8.6 Special securable object access level permission 

1. From the user group administration page illustrated in Fig. 8.18, locate the 

appropriate User Group and click the magnifying glass in the View column. As illustrated 

in Fig. 8.19, the user group modify page is displayed for the selected user group. 
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Fig. 8.19 User group modify – general information page. 

2. The page contains three tabbed forms. When the page is accessed it defaults to the 
General Information form. 

3. Click the Access Control Entries tab. 

As illustrated in Fig. 8.20, the Access Control Entries page for the Statistics User Group 
is displayed. 

Fig. 8.20 Access control entries page 
 

8.3.2.2 Configuring the securable objects 

1. The Securable Object Type: the list box shown in Fig. 8.20, allows the type of 
securable objects to be selected. 

Fig. 8.21.  The securable object list box. 
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You may need to use one or all of these securable object types to provide the required 
level of access from this group. To provide access to a product type, select Product Type 
from the drop down list and the screen will revert to the view shown in Fig. 8.20. 

2. Click Add. 

As illustrated in Fig. 8.22, the page updates to allow the selection of the required Product 
Type from those available to you and allows the access levels to be defined within that 
Product Type . The Product Type field can be expanded by means of the drop down list 
to show all the available Product Types. 

Fig. 8.22 User Group Product type selection and access permissions. 

3. Select one of the product types to which you wish to grant access and select the User 
radio button to provide the User level of permissions. Note: You are advised never to use 
the Modify Access control, as explained in Table 8.6. 

4. Click Save. 

Repeat steps 3 and 4 for all other product types to which this group is to provide access. 

Fig. 8.23 User group modified to provide access to two product types. 

Repeat steps 1 to 4 above for each of the Securable Objects you wish to make available to 
this group. For this Open Access group example, you will need to define the level of 
access to each of the securable object types. To do this the group access must now be 
defined for the following securable objects: 
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 Real Time Statistics

 Report

 Service

 User

As described above for Service Types, select the securable object from the drop down list, 
click Add, open the drop down list against the Service or the User and select one item 
and click Save. Repeat as required for further Services and Users. 

Note: The USER securable object will permit members of the Group to administer the 
User permissions. Do not confuse this with the need to make Users members of the 
group. 

Real Time Statistics and Reports are all hidden by default. These objects may all be made 
accessible by changing the level of access from Hidden to Full Access, as described 
below. 

Fig. 8.24 Real Time statistics default setting of all hidden. 

Select the Modify icon against the ALL (Default) object. The screen will update as shown 
below. 

Fig. 8.25 Real Time Statistics access control entries 

Select the Full Access radio button and click Save. 
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Fig. 8.26. Real Time Statistics updated to Full Access. 

Using the same principles described above, the Securable Object Type: Reports may also 
be made available to this group. 

You also have the possibility of hiding those reports which are of no use to your users. 
When doing this, you must be aware that a given report is accessible from various points 
on the screen and you can control access from each of these separately. Table 8.7 
explains the locations of the report access location. 

 

Location/Report Type: Description 

Reports/Platform: These are Platform reports which are accessed via the Main 
Navigation Menu option REPORTS & GRAPHS > Platform 

reports and are displayed on the reports & graphs page. 

Reports/Services: These are Service reports which are accessed via the main 
navigation menu option REPORTS & GRAPHS > Service 

reports and are displayed on the reports & graphs page. 

Service/Reports: These are Service reports which are accessed from the service 

administration page on the Reports tab. 

Advanced Searches: These are the Advanced Searches reports that are accessed via 
the Main Navigation Menu option CONFIGURATION > smd 

administration and are displayed on the Advanced Search 

tab form on the smd administration page. 

Table 8.7. Report Location, Type and description 

The report names are also followed by the level of access required to access the report. 

The Access Level may be different for each type of securable object and the explanation 
is provided in Table 8.5 and Table 8.6 above. In this case, Reports may have one of three 
levels of access: User, List only or Hidden. The default is to provide the lowest level of 
access. 
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8.3.3 Join a User to a User group 

1. From the User group Administration page as shown in Fig. 8.16, locate the user 

group you wish to assign a member to and click the magnifying glass against that entry in 
the View column. You will be presented with the User group modify page, as shown in 
Fig. 8.27. 

Fig. 8.27 Statistics user group - User group modify tabbed page 

3. Click the Members tab 

Fig 8.28 User group modify – members page 

As you can see from Fig. 8.28, there are no members currently allocated to the Statistics 
group. 

4. Click Add 

The tab label changes to Non Members and a list of all the users who are not members of 
the group are displayed. 
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Fig. 8.29 User group modify – non-members tab 

When first adding members to a new group, ALL of your users will be eligible to be 
assigned to the group. If you already have many users, there will be many pages of non- 
members. 

5. Click the check box in the Select column of the user you wish to become a member of 
the group. 

6. Click Join. The page updates to show the message: 

Selected Member(s) have been added 

The members selected for addition to the group also disappear from the list of non 
members. See Fig. 8.30 

Fig. 8.30 Updated Non members page. 

Note how the screen still refers to the user group to which you are adding members. 

7. Click Members List. The page updates to show all members currently assigned to the 
group. 
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Fig 8.31. Updated members list 
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9 SERVICE PROVIDER 

9.1 Modify Service Provider Details 
Clicking SERVICE PROVIDER in the navigation opens the 
service provider modify screen illustrated in Fig. 9.1. This 
allows authorised users to modify the Service Provider 
account details. 

 
 
 
 
 
 

Fig. 9.1 Service Provider - Modify Screen 

1. Edit or update any of the displayed parameters, by clicking in the text fields that are 
to be edited, and making the necessary changes. 

2. Click Save to save the Service Provider account details. 
Alternatively; Clicking on Cancel will cancel all the changes that have been made and 
return all the field values to be as they were when the screen was first opened. 

Note: If any changes are made to the mandatory fields, i.e. those marked with a red 
asterisk, it is important that entries to these fields are completed. Failure to complete them 
will cause the system to prompt for the missing details before saving. 



Ride Web Interface Service Provider User Guide 

Issue A3i 08 August 2019.  

Copyright © BT 

 

 

 

10 Modify Access Control 

Note: You are advised not to use these screens to control privileges against Service 
Providers, Services of Users, but to use the facilities available under User Groups. 

This is advised for two reasons: 

 Mixing the use of Modify Access Control and User Group permissions will slow the 
screen refresh speed as all the permissions must first be checked before each screen 
is displayed and

 Mixing the use of Modify Access Control and User Group permissions can be 
confusing. Make life simple by creating suitable groups and then make your Users 
members as required.

This applies to a Securable Object and controls the permissions restricting or allowing 
access to it. It may be set against: 

 Service Provider

 Service

 User and

 User Group

The principle of operation is to: 

1. Select the Securable Object to which you wish to control access. E.g. a User 

2. Locate the Access Control / Security page for that Securable object. E.g. the 

User Security page 

3. Define the permissions which allow access to the Securable object. E.g. hide this 
User from another User Group. 

The location of the Access Control / Security page varies for different Securable 

Objects. 

 Service Provider Access Control is available directly from the Service Provider

Administration page via the Access Control Icon 

 Service Access Control is available directly from the Service Administration
page via the Access Control Icon 

 User Security is available from the User Administration page via the Modify 

Icon, to the User Modify page where the Access Control link becomes available. 

This link will take you to the User Security page.

 User Group Security is available from the User Group Administration page via 

the Modify Icon, to the User Group Modify page where the Access Control link 

becomes available. This link will take you to the User Group Security page.
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Each of these Access Control / Security pages has the same format. It is a tabbed 

display, with User Group, User and Summary tabs. Each Tab shows how the defined item 
has access to it from the listed Users and User Groups controlled. 

 

11 SERVICE ADMINISTRATION 

11.1 Introduction 
Service Administration contains details of all services belonging to the Service Provider. 

Using the tools and facilities provided, a Service Provider Administrator may: 

 Update Service Announcements

 Modify Service Variables and Configuration

 View Real Time Statistics

 View Scheduled Changes to their Services

 Run a Selection of Reports pertaining to individual Services

 

From the Navigation Menu, click SERVICE 

ADMINISTRATION. The service administration main 

screen illustrated in Fig. 11.1 is displayed. 
 
 
 
 

Fig. 11.1 Service Administration Main Screen 

Services are displayed in ascending order by Service ID and depending upon the number 
of entries the display may extend to more than one page. Up to ten services can be 
displayed on a single page. 
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A brief description of the service administration main screen fields are provided in 

Table 11.1 and a description of the service administration functions with instructions 

on how to use them is provided in Table 11.2. 
 

 

Service Administration Fields 

Service ID This column displays the unique Service ID (Code) of all active Services. 
The service ID is an automatically system generated sequential number, 
added to each service on its creation. 

Service Name This column provides read only display of the Name assigned to each 
service. 

Service Type This column provides read only display of the type of service. 

Calls Today Displays the number of calls to the service, since midnight. 

Status This column displays the current status of the service. 

 

 

 
RED: Not deployed 
The service has not yet been sent out to any nodes. 

AMBER: Suspended 
Although the service has been deployed to the nodes it is currently 
suspended. 

YELLOW: Service Changing 
There is a change in progress that will affect the service configuration. 

GREEN: Active 
There are no changes in progress for this service. This service is deployed 
to all nodes 

Table 11.1 Service Administration fields 
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Service Administration Functions 

Search Initiates a search for a specified service. 

Service This search is based on the Service Name (or part of the name) typed 
into the search text field. 

Clicking    starts the search. 

Clicking   clears the search criteria (see “Search for a Service”). 

Refresh Refreshes all data displayed on the service administration screen 

(Fig. 10.1). 

Access 

Control 

Used to apply access controls the selected service. See Modify Access 
Controls. 

View  Click to open a page displaying the currently held details for this Service 
(see "General Information" ). 

Help 
 

Click to access the On-line help that is applicable to the content of the 
displayed page. 

Table 11.2 Service Administration functions 
 

11.2 Search for a Service 
To search for a specific Service, or for specific Services, and display only details of those 
services on the Service administration screen, use the ‘Search Service’ facility as follows: 

1. Enter the Service name or the first part of the name as a search string in the 
Search Service text field. 

Note: The only characters that can be used in the search text box are; (A-Z) (a-z) (0-9) 
and (*). If only part of the name is known, the wild card (*) can be used. It must be the 
first character in the search string, and it will modify the search in that the remaining 
characters in the search string, can be anywhere in the Service Name. 

2. Click , or press <ENTER> to start the search. 

If the searc uccessful and matches the search string entered, the display will show 
only the required Service(s) and the appropriate administration procedures can be carried 
out. 

If the search is unsuccessful, the display will display the message: 

Sorry, no records Found 

The search should be restarted as follows: 

a) Click to clear the search string from the Search Service text field, and return to 
the display of all Services. 

b) Return to step 1 above to repeat the procedure, this time using a different search 
string. 



Ride Web Interface Service Provider User Guide 

Issue A3i 08 August 2019.  

Copyright © BT 

 

 
 

11.3 The Service Administration Tabbed Display 
The service administration Tabbed Display consists of up to ten pages, depending on 

the service type. Each page is accessed by clicking the tab caption. Each page contains 
differing tools and features useful in service administration and maintenance. The tabbed 
pages will be described in detail in the subsequent sections. 

All service types will show the following tabs: 

 General Information (default page)

 Variable Overview

 Variable Details

 Real Time Statistics

 Scheduled Changes

 Shortcuts

The following tabs may be displayed, depending on the service type: 

 Advanced Features

 Data Capture Status

 Session Status

 Call Flow Diagrams

11.3.1 Accessing the Service Administration Tabbed Display 

From service administration main screen illustrated in Fig. 10.1, click for a particular 

service. 

The service administration screen is updated as illustrated in Fig. 10.3. The General 

Information page is displayed by default. For quick reference, an information bar is 
provided at the top of the screen displaying the following information: 

Service Code - An automatically system generated sequential number, added to 
each service on creation. 

Service Name - The user entered name for the service. 

Service Provider Name - The name of the Service Provider. 

Service Status (Applicable to services like Televote, which are active for a defined 
period) - The status of the service. 

This information remains displayed at the top of the screen as users navigate between 
pages. 

Fig. 11.2 Information Bar 
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11.4 General Information 
The General Information page includes the following read only details: 

Service name The name of the service. 

Deployment date. The date and time of service deployment. 

Deletion date The date may be set, either as Now, or at some future date, as 
specified by the user. 

Last modified Time and date of the last modification. 

Service type The service type that this service is associated with. 

Service state Service status may be Active, Suspended, or, Not Deployed. 

Fig. 11.3 General Information page 
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A summary of the Functionality for a Service Provider is provided in Table 11.3. 

General Information Functionality 

 
 

Name Details 

Service Properties 

Web Control Gives the user the ability to control this service using the web 
interface. 

Service Variable Pages Allows users to view the Service Variables page. 

Maintain Announcements Allows users to modify announcement variables 

ASCII Announcements Allows users to upload custom ASCII-type announcements 

Professional 
Announcements 

Allows users to update announcement variables by making a 
selection from the available list of professional 
announcements 

User Announcements Allows users to upload custom announcements from their 
local PC 

Maintain Non 

Announcement Variables 

Allows users to maintain non announcement variables i.e. 
any variable other than announcements variables. 

View DDI Aliases Allows users to view aliases that have been assigned to DDI 
variables. 

View DDI Values Allows users to view the values assigned to any DDI variables 
within this Service Type. 

Basic Control Allows the user Basic Control of the service 
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Statistics 

Display RTS Page Allows users to view Real Time Statistics for services of this 
type. Without this property set, no Real Time Statistics may 
be viewed. 

Reports and Graphs Page This property controls the display of Reports and Graphs for 
services of this type. With this property set, the user is 
displayed an additional tabbed page under Service 
Administration listing some of the available statistical reports. 

Display RTS Trip Counter This property allows the user to view the RTS Trip Counter for 
the service. The Trip Counter is analogous to the trip counter 
in the car – it is the number of calls since either the service 
was created, or the last reset. 

Display RTS Trip 
Percentage 

This displays calls that have been made since the last reset 
as a percentage of the total calls. 

Display RTS Calls Today This counter displays the number of calls that have been 
made since midnight on the same day. This counter cannot 
be reset. 

Display RTS Total Calls This counter displays the total number of calls that have been 
made since the service creation. This counter cannot be 
reset. 

Display RTS Trip Counter 
Before Last Reset 

This counter displays the previous value of the RTS Trip 
Counter (prior to a reset). 

RTS to report answered 
calls only 

The web interface will only display answered calls in any RTS 
report. 

Voice and Data Capture Features 

Voice and Data Capture 

Functionality (all users) 

This property enables Voice and Data Capture Functionality 
for the Service. Service Types that make use of Voice and 
Data Capture include ‘Message Link 2’. 

Session Summary Page This property provides an additional page to Service 
Administration. 

Data Capture Page This property provides an additional page to Service 
Administration, which contains details of Message Link 2 
sessions 

Table 10.3 General Information functionality 

Note: The information listed in Table 11.3 above varies according to the type of service 
that is being managed. 
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11.4.1 Modify Service Details 
1. To modify the details displayed on the General Information page, click Modify. 

The screen updates to display the page shown in Fig. 10.4. 

 
Fig. 11.4 Modify General Information 

2. Modify the text entry fields and/or radio buttons as required 

3.  Click Save to save the details and return to the General Information page. 

Clicking Cancel will undo any changes that have been made to the entry boxes. 

Clicking Exit will close the current page (without saving any changes) and re-open 
the General Information screen. 

4. Click Print to open the Print dialogue box. Refer to “Printing” for information on 
printing. 

A list of Service Variables 

List of Service Variables 
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Variable Name Variable 
Description 

Variable Type Variable Value 

SERVSTRT Service Start Date/Time 09:46:33 28-May-2002 

SERVSTOP Service Stop Date/Time 23:59:59 31-Dec-2037 

NOPTIONS Number of 
Options 

Short Integer 30 

RINGTONE Play Ringtone? Boolean Yes or No radio button 

PREVTANN Pre-vote 
Announcement 

Announcement Clicking on the loudspeaker icon 
link will open the ‘Announcement 
play’ page containing ‘Windows 
Media player’ and play the 
announcement 

Table 11.4 View Service Details - Service Variables Example 
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11.5 Variable Overview 
To access the Variable Overview page: 

1. From the service administration main screen illustrated in Fig. 10.1, click to 

view a particular service. The Tabbed Display screen opens. 

2. Click on the Variable Overview tab. The screen updates to show the page shown 
in Fig. 11.5 below. This example is for a Message Link 1 service. 

Fig. 11.5 Variable Overview 

Use scroll bars as necessary to view the service variable details. 

3. To print the details as displayed on the Variable Overview screen, click Print. See 
Section “Printing” for more details on printing. 

4. To ensure that the data displayed on the screen is the up-to-date, click Refresh, 
which updates all data on the current screen. 

5. To play an announcement Click  to open the announcement play page (see 
Announcement Playback”). 

To modify the variable values refer to “Variable Details”. For Schedule updates 
refer to “Scheduled Changes”. 

6. Click Back to return to the service administration main screen. 
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11.6 Variable Details 
To access the Variable Details page: 

1. From the service administration main screen illustrated in Fig. 11.1, click to 

view a particular service. The tabbed display opens. 

2. Click the Variable Details tab to display that page. 

The screen updates to show a page similar to that shown in Fig. 11.6 below. The 
screen lists the variables associated with the selected service, with up to ten variables per 
page. Further pages are accessed by means of the paging tool. For details of the paging 
tool refer to paragraph “Paged Lists”1. 

Fig. 11.6 shows a Variable Details page for a typical ‘Message Link 1’ type 

service. Service variables are used to configure every feature of a service. A description 

of the features provided via the Variable Details page is provided in Table 11.5. 

Fig. 11.6 Variable Details 
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Variable Details page Features 
 

Feature Description 

Search 
Service 
Variable 

Initiates a search for a specified service variable. This search is based on 
the Name (or part of the name) typed into the search text field. 

Click          starts the search. Click       clears the search criteria (for 
furt rmation on using the facility r to “Search for a Service”. 

Variable 
Description 

The description provides some information describing the purpose of the 
variable. 

Value The value column displays the current value assigned to the variable. 
Where the variable value is an announcement, the icon is displayed. The 

announcement can be played by clicking on the icon  r to 
“Announcement Playback”). 

Modify This allows the user to view or modify the variable by clicking 
 

If the column displays then the variable may only be viewed. 

Refresh Clicking this link refreshes the display to show the most up to date variable 
values. 

Back Clicking to return to the service administration main screen. 

Table 11.5 Variable Details page features 

A variable that can be edited has in the Modify column against the variable 
description. Clicking this link allows the user to view some extended detail for the variable, 
and provides the facility to schedule a variable update. Variable updates can be 
implemented immediately, or, scheduled for some date in the future. Details on how to 
update a variable value are provided in the subsequent sections. 

Some variables may be read only. Read only variables have         in the Modify column 
against the variable. Clicking this link opens a page displaying extended details for the 
variable. 
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11.6.1 Updating Service Variables 

1. To update a service variable, open the Variable Details page as described in 

paragraph “Variable Details”. 

2. Select the variable by paging through the list and click on   . 

An example of the Modify Service Variable screen illustrated in Fig. 11.7 is 
displayed. The various variable parameters are displayed with the current variable value. 
All possible variable parameters, covering all the different Service Types, are listed in 
Table 11.6. 

Any scheduled variable changes are shown in the Future amendments area at the 
bottom of the screen. 

 

Fig. 11.7 Modify Service Variables 

3. Change the Current Variable Value by selecting the appropriate radio button or 
entering the new value in the text field. 

4. Click on the Calendar icon, to set the required change date. 

The Calendar dialogue opens. 

5. Use the Calendar controls to set the Time and Date (Refer to “The Date and Time 
Calendar Dialogue Control” for Calendar Dialogue details). 

Change Date set to Now will implement the change immediately the change is 
saved. 

6. Once a variable value has been entered and the Change Sate set, click Save to 
carry out the update. Clicking on Cancel, prior to saving, will undo any changes. 

7. Click Refresh to refresh the display to show the most up to date variable value. 
Note: The screen refresh may not happen immediately - check the status circle. 

8. Click Back to return to the list of service variables (Fig. 11.6). 
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Variable Details - Service Variable Parameters 
 

Parameter Description 

Variable Name Variable name is the eight-character unique name assigned to each 
variable. 

Variable Alias Unique to DDI Numbers. Allows the user to assign an alias to the DDI 
to identify it. The alias is used in Reports and Graphs, and Real Time 
Statistics. This field is limited to 32 alphanumeric characters. 

Variable 
Description 

The description provides some information describing the purpose of 
the variable. 

Variable Type The variable type provides the user with an indication of how the 
variable is used as well as the type of data that can be entered as a 
value. 

Maximum Value States the maximum value allowed for this variable. 

Minimum Value States the minimum value allowed for this variable. 

Length Length informs the user how many digits the variable value must equal 

String Mask The String Mask dictates the format of the variable value: 

 0 

9 

# 

 
L 

? 

A 

a 

& 

C 

A number is required. No + or - allowed 

A number (or space) is optional. No + or - allowed 

A number (or space) is optional. Spaces will be removed. No + 
or - allowed 

A letter from A to Z is required 

A letter from A to Z is optional 

A letter from A to Z or a digit 0 to 9 is required 

A letter from A to Z or a digit 0 to 9 is optional 

Any character or space is required 

Any character or space is optional 
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Parameter Description 

* Current Variable 
Value 

This displays the current variable value by default. This value can be 
presented as (and modified in) a text field, a set of radio buttons, a 
drop-down list or a set of check boxes. 

* Change Date The change date is the date at which the variable value is to be 
implemented. Click on the Calendar icon to open the Calendar 
dialogue and set the change date. 

Accelerated Value Indicates if the variable is to be accelerated, i.e. sent separately to the 
nodes immediately Save is pressed instead of being routed through 
the regular queue. 

Table 11.6 Service Variable Details Parameters 
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11.6.2 Future Amendments 
When a variable change has been scheduled for the future, a Future Amendment is 
added to the list of amendments on the Modify Service Variable page in Fig. 11.7. 

The future amendment record shows the value that the Service Variable is to be changed 
to, and the time and date that the change will be implemented. The user is also given the 
opportunity to modify the future amendment or even delete the future amendment 
altogether. 

As future amendments are implemented, i.e. at the change date, they are removed from 
the list. 

 

Fig. 11.8 Future Amendments 

Change Date The change date is the date at which a scheduled change to the 
variable value is to be implemented. 

Value The new value for the variable 

Modify Click   to alter the variable value and/or change date scheduled in a 
future amendment. 

Delete Click   to delete the future amendment. 

Modify Future Amendment 

1. To modify either the value or change date of the future variable amendment, click  

The Modify Future Amendment screen illustrated in Fig. 11.9 is displayed. 
 

Fig. 11.9 Modify Future Amendment 

2. Modify the Variable Value, by editing the text in the text field or selecting an 
alternative radio button. 

3. To modify the Change Date, click      and then use the Calendar controls to set the 
new date and time. 

4. To save any changes and exit to the Modify Service Variable screen, click Save. 
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11.6.3 Announcement content 
As a Service Provider (SP) you are at liberty to design the announcement wording of your 
choice providing the announcements are legal, decent, truthful and honest. Where a 
foreign language is used, BT reserves the right to request a translated transcript. Where 
an announcement contravenes the above stipulations, BT reserves the right to withdraw 
the service. As a Service Provider if you record your own announcements directly onto 
RIDE or supply announcements for BT to load, it is your responsibility to ensure that the 
recording is of a suitable quality i.e. it is audible to the caller without background noise 
and distortion. As a Service Provider you may request BT to load an announcement. It is 
advisable for the sender to retain an original audio copy, as BT will not be liable for any 
loss or damage. 

You are advised NOT to place the most important information in the first few 
seconds of the message. This will help to avoid the caller missing the message and 
allows them to confirm they have dialled as they intended. For example the 
message could commence” Thank you for voting for…” 

 

11.6.3.1 Announcement vetting 

Service Providers are obliged by ICSTIS to provide appropriate announcements. The 
announcement content may be checked by BT because of the potentially bad impact of a 
rogue announcement. It is possible for all announcements loaded by the Service Provider 
to be vetted by BT before they become active. This facility will be invoked for those 
Service Providers found to be using announcements, which do not conform to the content 
guidelines above. Vetting of announcements will only take place during normal office 
hours: 09:00 -17:00, Monday to Friday. All announcements submitted for acceptance 
outside these normal working hours will wait for acceptance until the next working day. 

 

11.6.3.2 Announcement recording format 

When the Service Provider requires BT to load their announcements, they must be 
supplied to BT in a suitable format (C-ITU (CCIT) G.711 8 khz, 8-bit, mono A-law wave 
files). 

It is possible for BT to convert some formats into the one defined above. 
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11.6.4 Updating service announcements 
Service announcements may be updated in a similar way to variable values. From the 

Variable Details page illustrated in Fig. 11.6, select the required announcement from the 

list and click on the adjacent    icon. 

This opens the Modify Service Variable screen illustrated in Fig. 11.10. 
 

Fig. 11.10 Updating Service Announcements 

The details for the announcement are displayed and playback can be achieved by clicking 
on in the Current Variable Value field. All parameter fields are as previously described 
in paragraph “Updating Service Variables” , with the exception of the mandatory field, 
Select new announcement from. 

Any scheduled announcement updates are shown in the Future Amendments area at the 
bottom of the screen. 

1. Select the announcement type from the Select new announcement from drop- 
down list, as illustrated in Fig. 11.11, and proceed as follows: 

If selecting from ASCII announcements, refer to “Uploading ASCII Announcements”. 

If selecting from a list of announcements, refer to “Selecting Announcements from a 
List”. 

If selecting announcement from your machine, refer to "Uploading an Announcement 
from ‘My Machine”. 
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Fig. 11.11 Service Administration - Selecting Announcement Type for Upload 

 

11.6.5 Uploading ASCII announcements 
ASCII type announcements are used when the intended receiver is an ASCII telephone. 
An ASCII telephone is a device that allows people with hearing or speech impairments to 
communicate over the telephone. 

Fig. 11.12 Uploading ASCII Announcements 

1. Select ASCII Announcements from the Select new announcement from drop-down 
list. 

2. Enter the text to be sent to the ASCII telephone in the Announcement text field. 
The maximum number of characters or numbers that may be entered is 100. 

3. Assign a file Name to be associated with the entered text. Ensure that the name is 
entered with the correct file extension (.wav). 
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4. One of the following encoding types can be selected from the Select encoding 
type drop-down list: 

Baudot An International Telecommunication Union-Telecommunication 
Standardisation Sector (ITU-T) standard for 45-bps full duplex modems. 

V.21 An International Telecommunication Union-Telecommunication Standardisation 
Sector (ITU-T) standard for 300-bps full duplex modems. 

V.23 An International Telecommunication Union-Telecommunication Standardisation 
Sector (ITU-T) standard for 600-bps and 1200-bps full duplex modems. In this case, 
1200-bps is selected as the transmission rate. 

5. Click to set the required change date. The Calendar dialogue is displayed. 
Use the Calendar controls to set the time and date. Refer to “The Date and Time 
Calendar Dialogue Control” for details of the Calendar controls. 

6. Click Save to upload the ASCII text. 

Clicking Cancel will clear all entries. 

Clicking Back will close the Service Variable Modify screen. Any unsaved changes will 
be lost. 

 

11.6.6 Selecting announcements from a list 
Users may also select announcements from one of the following lists: 

 List of Professional Announcements
The list of professional announcements contains a list of standard, professionally 
recorded, announcements. 

 List of All Announcements
The list of all announcements contains current, deleted, and ASCII-type 
announcements. It should be noted that a deleted announcement would only be 
present in the list for a period of 60 days after deletion. 

 List of Current Announcements
The list of current announcements contains all announcements that have been 
uploaded to services that are still currently deployed. Announcements will remain in 
this list until deleted with their respective services. 

 List of Deleted Announcements
The list of deleted announcements contains all announcements that have been deleted 
from the live platform. Announcements are deleted in the following ways: 

- An existing announcement on the platform has been updated with a new file. The 
original file is then deleted and made available for selection from the list of deleted 
announcements for 60 days before it is permanently cleared from the system. 

- A service has been deleted within the last sixty days. In this case, all 
announcements associated with the service are deleted and are available for selection 
from the list of deleted announcements for 60 days before permanently cleared from the 
system. 

Note: Announcements with lengths outside of the range stated on the Service 
Variable Modify page are NOT listed. 
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My Machine 

See paragraph "Uploading an Announcement from ‘My Machine’" for details. 

1. Select the list to upload an announcement from in the Select new announcement 
from drop- down list. 

Fig. 11.13 Selecting Announcement Type for Upload 

Once a list has been selected, a further drop-down list will be displayed with all 
announcements that are assigned to that particular list. Fig. 11.14 shows the List of 
professional announcements. 

 

Fig. 11.14 Selecting Announcements for Upload 

All announcements are listed in alphabetical order and are presented in the format: 

<Announcement Name>.wav - <Announcement Description> 

2. Select the appropriate Announcement from the list. 

3. If required, a new announcement description can be added into the 
Announcement description text field. This description will be displayed next to the File 
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Name as a new entry in the list of current announcements and the list of all 
announcements. 

4. Click Save to upload the announcement. An entry is added into the Future 
Amendments list for the scheduled announcement upload. 

Clicking Cancel will clear the selected entry from the Select new announcement 
dropdown list. 

Clicking Back will close the Service Variable Modify screen. Any unsaved changes will 
be lost. 

 

11.6.7 Uploading an announcement from ‘My machine’ 
1. Select My Machine from the Select new announcement from drop-down list to 
upload an announcement from a location on the local PC. 

A new button labelled Browse will be displayed below the drop-down list. 

Fig. 11.15 Browse for Announcement on ‘My Machine’ 

2. Click Browse to select an announcement from a specific location. The Choose 
File dialogue is displayed. 
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Fig. 11.16 Choose File 

3. Use the drop-down list to select the exact location of the announcement file for 
upload, and click on the file, or enter the full path of the file into the File name: text field. 

4. Click Open. 

The Choose File dialogue closes. 

5. If you wish to monitor the upload progress of a large file, tick the Upload with 
progress bar checkbox (next to the Browse button). 

6. Click    and use the Calendar controls to set the Time and Date. Refer to 
paragraph “The Date and Time Calendar Dialogue Control” for details of the Calendar 
controls. 

7. Click Save to upload the announcement. 

8. If a warning prompt similar to that in Fig. 10.17 appears, click Yes. 
 
 

 
Fig. 11.17 ActiveX Control warning message 

The Announcement Quality Results page, illustrated in Fig. 10.18, opens, 
presenting a graphical analysis of the sound file. The Health indicators should all be 
green. In this example the Peak volume is Too high and the Average volume is High. 
This indicates the volume should be adjusted, and a decrease of 6,8 dB is suggested. 

9. To accept the suggested adjustment, click Normalise. To modify the adjustment, 
enter the new value in the dB text field before clicking Normalise. 
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Fig. 11.18 Announcement Quality Results 

If the change date value is set to anything but Now (in which case the change is 
effected instantly) an entry is added into the Future Amendments list for the scheduled 
announcement upload. 

Clicking Cancel will clear the entry from the Upload New Announcement field. 

Clicking Back will close the Service Variable Modify screen. Any unsaved changes will 
be lost. 

The SPA/SPU is automatically returned to the Variable Details main screen. 

Note: Please refer to Appendix A, “Making a Recording” for details on recording 
announcements. 
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11.6.8 Future service amendments - announcements 
Announcements may be selected for upload as described in Uploading ASCII 
Announcements , Selecting Announcements from a List and Uploading an 
Announcement from ‘My Machine. These announcement uploads can be configured to 
take place at a particular date and time in the future by setting the Change Date. When 
an announcement update has been scheduled for the future, the change is added to the 
list of Future Amendments on the Modify Service Variable page as illustrated in Fig. 
11.19. 

 

Fig. 11.19 Future Announcement Updates 

The future amendment record shows the time and date of the scheduled change i.e. the 
Change Date, and the Value of the service variable, i.e. an announcement. The 
announcement may be played by clicking on    (refer to Announcement Playback for 
details of playing announcements). 

The user is also given the opportunity to modify the future amendment, or even delete the 
record altogether. 

This future amendment will be removed from the list at the time of implementation i.e. the 
Change Date. 

1. To modify either the announcement file or change date of the future amendment, 
click 

The Modify Future Amendment screen, illustrated in Fig. 11.20 is displayed, 
showing the Variable Name, the Select announcement from drop-down list, and the 
Change Date that the announcement will be updated. 
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Fig. 11.20 Modify Future Service Announcements 

2. From the Select announcement from drop-down list, select the location from 
which the announcement is to be uploaded. The options available are: 

 ASCII Announcements

 List of Professional Announcements

 List of All Announcements

 List of Current Announcements

 List of Deleted Announcements

 My Machine

To upload an ASCII Announcement, refer to the instruction in paragraph Uploading 
ASCII Announcements. 

To upload an announcement from a list, refer to the instruction in paragraph 
Selecting Announcements from a List. 

To upload an announcement from My Machine, refer to the instruction in paragraph 
Uploading an Announcement from ‘My Machine. 

3. To modify the Change Date, click  , and then use the Calendar controls to set the 
date and time. Refer to paragraph The Date and Time Calendar Dialogue Control for 
details regarding the Calendar controls. 

4. Click Save to save any changes and exit to the Service Variable Modify screen. 

Clicking Cancel will undo any unsaved changes. Clicking Back will exit the Modify 

Future Amendments screen without saving any changes. 

Note: It may not always be possible to modify a future amendment if the change 
date has already passed. 

 

11.6.9 Recording announcements 
In order to customise service announcements, the user must first record the required 
announcements using a sound recorder utility. Announcements must also be recorded in 
the correct file format (.wav) for deployment to the service nodes. 

Microsoft Sound Recorder allows users to record announcements for upload to the RIDE 
Web Interface. Refer to Appendix A - Introduction to Microsoft Sound Recorder for 
further information on recording announcements. 
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11.7 Rule violations 
A Rule Violation will occur when there is a conflict between one or more variable settings 
with inter-dependencies. These interdependencies are often as simple as: start time/date 
must be before stop time/date. They will vary between service types. 

You are notified of a Rule Violation as and when it occurs (see Fig. 11.22). After a 
variable modification is saved its status will be one of the following: 

 

Status Description 

 Green indicates a Valid variable update. 

 

 

Yellow Indicates a Valid variable update that will not be 
implemented because there is a Rule Violation for another 
service variable 

 

 

Red indicates a Rule Violation The Rule Violation Status is 
displayed next to the variable name in the Scheduled Changes 
page, as illustrated in Fig. 6.3. 

Table 11.7: Variable update status indicators 

As an example, if you try to modify the Event Stop Time variable with a date/ time prior to 
the Event Star Time variable, you will encounter a Rule Violation. 

To demonstrate this: 

On the Variable Details page, select Event Stop Time as the variable to modify. The 
Modify Service Variable page for the DRRPSTOP variable in Fig. 11.21 is displayed. 

Fig.11.21: Modifying the service stop variable 

2. In the Current Variable Value field change the date and time for the Service to stop 
before the Event Start Time i.e. In this example the Event Start Time is 08:00:00 27-Apr- 
2005, so change the Event Stop Time to 07:00:00 27-Apr-2005. 

3. Set the Change Date to Now. 

Click Save. The Message in Fig. 11.22 is displayed. 
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Fig.11.22: Rule Violation error message 

4. Click OK to acknowledge the message. After a few moments the Modify Variable 
Details page will refresh. 

5. Click the Scheduled Changes tab. The Scheduled Changes page in Fig. 11.23 is 
displayed 

Fig.11.23: Scheduled changes page 

The message in Fig.11.22 states that, the Event Start Time must be less than or equal to 
the Event Stop Time. 

To correct this particular scenario: 

On the Variable Details page select Event Stop Time. The Modify Service Variable page 
for the DRRPSTOP variable in Fig. 10.24 is displayed. 
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Fig.11.24: Correcting Rule Violation – step 1 

2 Under Future Amendments in the Modify column, click  . The Modify Future 
Amendment page in Fig. 11.25 is displayed. 

Fig.11.25: Correct the rule violation – step 2 

3. As illustrated in Fig. 11.26, change the Variable Value date/time back to 17:00:00 
08-May-2005 and set the Change Date to Now. 
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Fig.11.26: Correcting the rule Violation – step 3 

4. Click Save. 

5. Click Refresh. The Future Amendments section of the page disappears. 

6. Go to Scheduled Changes. The page displays a message stating: 
No scheduled changes for this service 

Go to the Variable Overview page and you will note that the Event Stop Time variable 
has changed back to 17:00:00 08-May-2005. 
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11.8 Real time statistics 
Real time statistics are a simple count of calls to the service. For this data to be available 
as quickly as possible, no individual call detail information is captured. The output may be 
filtered by various schema and regions. These filters are approximate and will not match 
exactly the results obtained from elapsed time reports where the schema and regions are 
applied. 

The Real Time Statistics (RTS) page is accessed in the following way: 

1. From the service administration main screen illustrated in Fig. 11.1, and click 

for a particular service. 

The service administration tabbed Display screen opens as shown in Fig. 11.3. 

By default, the General Information tab is displayed. 

2. Click the Real Time Statistics. The screen updates to show a page similar to that 
shown in Fig. 11.21 below. 

Fig. 11.21 Real Time Statistics 

The call statistics provided on this page are accurate to ten seconds, and with the facilities 
and options provided on the page, a user is able to quickly observe call statistics for the 
service, and also sort and present or print these statistics. 

 

11.8.1 Real time statistics - features 
Calls since last reset 

This counter will appear frozen when a Televote or Event is stopped. The counter will 
unfreeze and reset when a Televote or Event is started. 

It is possible to freeze, unfreeze or reset the call counters on some service types 

Calls before last reset 

The figure displayed here is the number of calls to the service prior to the last reset of the 
Calls before last reset counter 

Calls today 

The figure displayed here is the number of calls, successful or otherwise, that have been 
made to the service since 00:00 GMT. This figure cannot be manually reset, or frozen, 
using the RIDE web interface. 

Note: The RTS does not change with BST 

Total calls 
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The figure displayed here is the total number of calls, successful or otherwise, that have 
been made to the service since the DDI number was first assigned to it. This figure cannot 
be reset, or frozen, using the RIDE web interface. This figure is analogous to the reading 
from the tachometer found in a car. 

Note: Re-using an existing DDI within 24 hours results in previous statistics not 
being cleared 

 

11.8.2 Statistics filters 
An extended breakdown of real time call statistics can be displayed using the following 
filters: 

 Filter by DDI

 Filter by Region

 Filter by Region and DDI

10.7.2.1 Filter by DDI 

To show the total calls that have been made to each DDI attached to the service: 

1. Open the Real Time Statistic page as described in paragraph “Real Time 
Statistics”. 

2. Tick the By DDI checkbox and click or Refresh. 
 
 

Fig. 11.22 Real Time Statistics - Filtering by DDI 

3. The results of the DDI filtering are then presented on the Real Time Statistics 
screen (Fig. 11.23). 

This screen presents the call statistics in labelled columns and provides some 
additional information pertaining to each DDI. 
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Fig. 11.23 Real Time Statistics by DDI 

 

11.8.2.1 Filter by Region 

This is used to display the call statistics for a service, by a particular region (or group of 
regions). 

1. Select the type of regional breakdown that is required from the By schema drop- 
down list illustrated in Fig. 11.24. The available schemas are shown in Table 11.7. 

 

Fig. 11.24 Real Time Summary - Filtering by schema 

2. After selecting a schema, choose either a single region belonging to that schema, 
or all regions for that schema, from the By region drop-down list, as illustrated in Fig. 
11.25. 

 

Fig. 11.25 Real Time Summary - Filtering by Region 

3. Click to complete the filtering set-up process and initiate generation of Real Time 
Statistics (an example of a Real time statistics page filtered by region is shown in Fig. 
11.26). 
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Tip: Filtering by DDI can be combined with Regional filtering by also marking the 
‘By DDI’ check box. 

Note: Region is based on the Node answering the call. 
 

Fig. 11.26 Real Time Statistics by Region 

Sample Regional Schemas 

ITV Broadcasting UK Countries UK Regions 

Carlton Central England The Midlands 

Scottish Television Scotland Scotland 

Granada England North West England 

Carlton & LWT England London 

Carlton - West Country England South West England 

HTV Wales South West England 

Table 11.7 Sample Regional Schemas 
 

11.8.3 Sorting 
All columns may be sorted by clicking on the appropriate sorting symbol. There are two 
types of sort: 

 Primary

 Secondary

When two or more values in the primary sort column are equal, the secondary sort defines 
the order for these rows. 

DDIs are re-arranged into ascending order and call counts into descending order. 
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Text is sorted alphabetically into ascending order (A-Z). 

1. Click the light grey arrow  of the filter column to be used as Primary sort. 

The arrow changes to yellow   . 

2. Click the dark grey arrow   of the filter column to be used as Secondary sort. 

The arrow changes to blue  

An example of the primary and secondary sorting in use is shown in Fig. 11.27 (below). 
The primary sort is implemented on the Region column. Data in this column has been 
correctly sorted in alphabetic order. The secondary sort is implemented on the Calls 
today column. This secondary sort has defined the order for rows with repeated values in 
the primary sort column. 

Fig. 11.27 Real Time Statistics Sorting 

DDI 

This column displays all the DDIs that are attached to this service. 

DDI alias 

This column displays the user-assigned DDI Alias for each DDI used in the service. 

Region 

This column displays the Regions from which calls were made to the service. 

Calls since last reset 

This column displays the number of calls that have been made to the service since the last 
reset. 

Percentage since last reset 

The figure displayed here is the number of calls to the services since the last reset as a 
percentage of the total. 

Calls before last reset 
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The figure displayed here is the number of calls to the services prior to a reset of the call 
counters. 

Calls today 

This column displays the number of calls that have been made to the service since 00:00 
GMT. 

Total calls 

This column displays the total number of successful calls that have been made to the 
service since its start date. 

 

11.8.4 Statistics tools 
Refresh 

Clicking the Refresh link refreshes the display, updating the screen values that are shown 
to reflect the current situation of the selected service. 

Set Auto Refresh on 

This toggles on and off and will, if on, automatically refresh the display at around thirty- 
second intervals. Auto refresh is set to ‘ON’ by clicking on Set Auto Refresh ON. This 
changes the link colour to red and the link text to Set Auto Refresh OFF. Clicking this red 
link stops the screen from performing the auto refresh, and returns the link to its original 
state. 

 

NOTE: the use of Auto Refresh has a processing overhead which will delay the delivery of 
Real Time Stats if used heavily. You are advised to make minimal use of this facility 

Schedules 

Selecting this link causes the List of Scheduled Real Time Statistics Events to be 
displayed. 

 

Fig. 11.28: RTS schedules page 

You will notice that there are three scheduled RTS events already listed. 
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When the service was first created the system automatically allocated the Event Start 
time and Event Stop time as Now and Never respectively (See The Variable Overview 
page - extract). 

When the service was delivered, the Event Start and Stop times were allocated new start 
and stop times and the system automatically created the three events which, you will 
notice, are scheduled to run when the event starts (a Reset and an Unfreeze) and when 
the event stops (Freeze). 

The reason for this is to ensure that the event starts with a ‘clean slate’ the Reset and 
Unfreeze RTS Events are run the moment the event starts (effectively clearing any call 
counts with regard to Real Time Statistical information). Similarly, when the event stops 
the Freeze RTS Event is run. This eliminates any call counts for RTS purposes from 
being included after the event has stopped. 

When the RTS Events have been run they are no longer displayed in the List of Scheduled 
Real Time Statistics Events page. 

Back 

Click this link to revert to the service administration main page. 

Print 

Click this link to print the details as displayed on the Real Time Statistics screen. 

Last updated at… 

This shows the time at which the displayed statistics were accurate. 
 

11.9 Scheduled changes 
The Scheduled Changes page displays all variable modifications that have been 

scheduled under Variable Details. The page is accessed in the following way: 

1. From the service administration main screen illustrated in Fig. 11.1, click for a 
particular service. 

The service administration Tabbed Display screen in Fig. 11.3 is displayed. 

The General Information tab is displayed by default. 

2. Click the Scheduled Changes. The screen updates to show a page similar to that 
shown in Fig. 11.28 below. The screen lists the scheduled variable changes that will 

 
 

happen in the future. 

Fig. 11.28 Scheduled Changes 
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As the Change Date of each of the scheduled updates is reached, they are removed from 
the list. The available tools and features of the Scheduled Changes screen are detailed 
in Table 11.8 below. 

Scheduled Changes Screen – Features 
 

Parameter Description 

Change date The change date is the date at which the scheduled change to thevariable 
value is to be implemented. 

Description The variable description - provides the user with a hint as to the purpose 
of the variable. 

Old Value This is the original/current value of the variable. 

Status This is the value that the variable is changing to. 

A green disc indicates a Valid variable update. 
A red disc indicates a Rule Violation. 
An amber disc indicates a Valid variable update that will not be 
implemented because there is a Rule Violation for another service 
variable. 

Table 11.8 Scheduled Changes Screen - Features 
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11.10 Shortcuts 
Some services, like Televote are used for specific events. Ouside the event period, the 
service responds differently to callers. There are several actions required to move 
between the pre, active and post event periods. Ie the message played to callers, the 
setting and re-setting of counters etc. To simplify this change, a number of Shortcut 
options are available. 

1. From the service administration main screen illustrated in Fig. 11.1, click for a 

particular service. 

The service administration Tabbed Display screen in Fig. 11.3 is displayed. 

The General Information tab is displayed by default. 

2. Click on the Shortcuts tab. A screen similar to that in Fig. 11.29 is displayed. 

Fig. 11.29 Shortcuts 

3. In this example the televote is running and only one option is provided, which is to 

stop the vote. To do this, click       in the Execute column adjacent to Stop Vote. 

11.11 Advanced Features 
To access the Advanced Features page: 

From the service administration Tabbed Display, click Advanced Features. The 

Advanced Features page illustrated in Fig. 11.30 is displayed. 

Fig. 11.30: Advanced Features page. 
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11.11.1 Viewing the Audit Log for the Service 
The audit log provides information about changes that have been made to the service. 
The date and time, Event Number, User ID, severity and a message giving brief 
description of the event is recorded. 

To view the Audit Log: 

Click the Audit Log hyper-link on the Advance Features page illustrated in Fig. 6.1. The 
page updates and displays the Service - Audit Log, as illustrated in Fig. 6.2, where the 
report output is requested. 

Table 11.31: Audit report output selection 

The Audit Log report can be output to either: 

 Table

 Spreadsheet

Click View Report to display the report data. An extract of the report is displayed in Fig. 
11.32. 
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Fig. 11.32: example Audit log output report. 
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12 REPORTS AND GRAPHS 

12.1 Introduction 
Reports and Graphs allow users to view an analysis of 
service call data. Only one request for a report per user, 
may be submitted at a time. If a second request is 
submitted before the first one is complete, the first request 
is cancelled. 

The reports available are divided into two groups, accessible via the Service Reports and 
Platform Reports. 

 

12.1.1 Service reports 
Service Reports are service-specific and provide reports relating only to call data. These 
reports can be particularly useful when trying to establish the busiest calling period to a 
service, or display the results of a Televote for example. Call data is accurate to the 
nearest fifteen minutes. Individual reports are accessed by clicking on the relevant link. 

 

12.1.2 Platform reports 
Platform Reports provide the user with an audit log of all user actions and service 
changes, and a specific user access log. Individual reports are accessed by clicking on 
the relevant link. 

 

12.2 Filtering conventions 
The Reports and Graphs facility employs a set of controls with which to filter report data. 
Only filter controls relevant to the report are presented. The functionality of each type of 
filter is detailed in the following paragraphs. 

After clicking on a link to access an individual report, a page opens detailing the filtering 
options that are available for that report. All filters marked with a red asterisk (*) must be 
completed before the report can be run. If not, it will result in a dialogue box prompt 
requesting the necessary information from the user. Once the necessary amendment(s) 
has been made the user may proceed. 

The following filters are available: 
 

12.2.1 Filter by region - regional filter type 
With some reports it is possible to filter call data by the originating region from which the 
call was made (by Dialling Code), or, by the region in which the call was received (by 
Node). You will be presented with the following option as shown in Fig. 12.1. 

Select how to determine the region by selecting the radio button for the required option. 
Once an option has been selected, a further drop-down list will be displayed allowing you 
to further filter by a regional schema (refer to “Filter by Region - Regional Schema”. 
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Fig. 12.1 Report Filtering - Region Filter 

 

12.2.2 Filter by date and time period 
This filter allows the user to restrict report data to a particular time and date range. You 
may set a From Date and a To Date, where the From Date precedes the To Date as 
illustrated in Fig. 12.2.  These dates are set by clicking and then operating the 
Calendar dialogue controls as required. For details of how to use the calendar controls 
refer to “The Date and Time Calendar Dialogue Control”2. 

Fig. 12.2 Report Filtering - From/To Date Range Filter 

Note: From Dates and To Dates are both mandatory fields and must be set by the 
user before they may proceed. By default, dates and times are already set in these fields 
and are appropriate to the type of report and the data available. 

 

12.2.3 Filter into discrete time periods - the granularity filter 
You have the option to further filter the date range into discrete time periods. This can be 
achieved by setting another of the filters labelled Granularity as illustrated in Fig. 12.3. 
The Granularity drop-down list is active because it changes with the values entered in the 
From Date and To Date fields. Depending on the difference between the From Date and 
To Date, the time periods displayed in the Granularity drop-down list will offer the most 
appropriate choices. 

For example, if the difference between the From Date and To Date is one week, then the 
granularity offered might include 24 hours, 12 hours, 1 hour, and 30 minutes. If the date 
range was only half an hour, the granularity offered might include 5 minutes, 1 minute, 15 
seconds, and 5 seconds. 

Once the desired granularity has been set the call data returned in the report will be 
divided into these discrete time periods for the entire date range. 

Fig. 12.3 Report Filtering - Setting the Granularity 
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12.2.4 Filter by Service 
The filter illustrated in Fig. 12.4 allows you to restrict report data to a particular service 
selected from the Service Name drop-down list. 

Fig. 12.4 Report Filtering - Service Filter 

If the Service Name you wish to report on does not appear in the drop-down list: 

1. Click on More Service Name. ..... which, as illustrated in Fig. 12.5, is the last entry 
in the list. 

 

Fig. 12.5 More Service Name.... 

The screen in Fig. 12.6 is displayed. 
 

Fig. 12.6 More Service Name. ... screen 
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2. Using the navigation buttons or the page control at the bottom of the screen, locate 
the Service Name you want and click the check box in the Select column next to the 
Service Name. 

3. Click Continue. 

As illustrated in Fig. 12.7, the screen reverts back to the report filter page and 
displays the chosen service name in the Service Name list box. 

Fig. 12.7 The report filter page 

Alternatively: 

 To undo any selection click Cancel.

 To exit this screen click Back.

12.2.5 Time and Date Formats 
The dates entered by the user into the From Date and To Date fields can be set to either 
GMT (Greenwich Mean Time) or Local Time. 

The From Date and To Date can be set to GMT format by selecting Process all times in 
GMT from the drop-down list illustrated in Fig. 12.8. 

To set all dates to local time you should select Convert times from GMT to current local 
time from the drop-down list. 

 

 
Fig. 12.8 Report Filtering - Setting the Time and Date Format 

 

12.2.6 Summary or Detail Report 
Some reports allow you to produce a Detailed report or a Summary of the report by 
selecting the appropriate type from the drop-down list illustrated in Fig. 12.9. 
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Fig. 12.9 Report Filtering - Summary or detailed 

 

12.2.7 Filter by Number of Calls - Call Threshold 
Some reports allow you to filter services depending on the number of calls that have been 
made to them i.e. the Call Threshold. Setting this parameter results in the report only 
returning data for services that have either at least, or, less than that number of calls, 
depending on the type of report. 

The Call Threshold is set by clicking in the field. Edit the default threshold as required, as 
illustrated in Fig. 12.10. 

 

Fig. 12.10 Report Filtering - Call Threshold 
 

12.2.8 Filter by Region - Regional Schema 
You may choose to display call statistics for a service by a particular region, or group of 
regions. Some reports allow you the opportunity to state how the region is determined; 
either by dialling code, or by node. 

As illustrated in Fig. 12.11, to filter by region, you must first select the type of regional 
breakdown. This is performed by first selecting a Regional Schema from the drop-down 
list. The available schemas are shown in Table 12.1. Regional filters will be ignored when 
None is selected from the drop-down list. 

 
 

Fig. 12.11 Report Filtering - Regional Schema 

Once a Regional Schema is selected, a further drop-down list is displayed containing all 
available regions for the chosen regional schema (Fig. 12.11). You may then choose 
either a single region, or all regions for that schema by selecting an item from the list. 
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Available Regional Schemas 
 

For SDW data For RTS data 

ITV Broadcasting Regions ITV Broadcasting Regions 

UK Countries UK Countries 

UK Counties UK Regions 

Fixed v. Mobile  

Table 12.1 Available Regional Schemas 
 

12.2.9 Group By 
Some reports (i.e. Call - Multiple CLI Screening) allow you to group the result by any of 
the following: 

 Fixed v. Mobile

 ITV Broadcasting Regions

 UK Counties

 UK Countries

 

Fig. 12.12 Report Filtering - Group By 
 

12.2.10 Sort By 
The reports with a Group By option also allow you to Sort By any of the following: 

 Post Code

 Regional Grouping

 Call Count
 
 

Fig. 12.13 Report Filtering - Sort By 
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12.2.11 Severity Level 
For the Audit Log it is possible to filter by severity level: 

 All Severities

 Error

 Informational

 Warning

 

Fig. 12.14 Report Filtering - Severity Level 
 

12.2.12 Message Source 
The Audit Log also gives the user the opportunity to filter by message source: 

 All Sources

 SCC

 RUD

 WEB

Fig. 12.15 Report Filtering - Message Source 
 

12.2.13 Sort Column 
The Access Log supplies the option to select a sort column for the report: 

 Audit Date

 UserID
 
 

Fig. 12.16 Report Filtering - Source Column 
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12.3 Report Output Type 
Reports may be viewed in a variety of different formats depending on the type of report 
being run. All reports can be viewed as a table, or even saved to a spreadsheet and 
downloaded. The report output format is selected by choosing an item from the drop-down 
list illustrated in Fig. 12.17. Examples of each output type are detailed on the following 
pages. 

Fig. 12.17 Report Filtering - Select Report Output 
 

12.3.1 Output to Table 

Fig. 12.18 Output to Table 

Fig. 12.18 shows a typical table for the Call - Count to a Service report. The exact 
format of tables may vary from one report to another. The title and report filtering 
information is presented at the top of the page, with headed columns containing data and 
labels beneath. 

Click Print.to print the report. 

Click Back to exit the report. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in Export to Spreadsheet. 



Ride Web Interface Service Provider User Guide 
Issue A3h 27 April 2007. 

Copyright © 2004-2007 BT 

 

 
 

12.3.2 Output to Bar Chart 

 
Fig. 12.19 Output to: Bar Chart 

Fig. 12.19 shows a bar chart for a Call - Count to a Service report. The number of calls 
is displayed along the x-axis and the date is labelled on the y-axis. 

Click Print to print the report. 

Click Back to exit the report. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in Export to Spreadsheet. 
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12.3.3 Output to Line Chart 

Fig. 12.20 Output to: Line Chart 

Fig. 12.20 shows a line chart for the Call - Hold Time for a Service report. The number 
of calls is displayed on the y-axis and the dates and times are displayed along the x-axis. 

Click Print.to print the report. 

Click Back to exit the report. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in Export to Spreadsheet. 
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12.3.4 Output to Pie Chart 

Fig. 12.21 Output to: Pie Chart 

Fig. 12.21 shows a line chart for the Televote - Vote Count report. The number of calls 
received for each contestant, listed to the right, are displayed as colour coded segments 
proportional to the total number of calls received. 

Click Print.to print the report. 

Click Back to exit the report. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in "Export to Spreadsheet”. 

 

12.3.5 Export to Spreadsheet 
You may choose the option to export tabular data into a spreadsheet. The data within the 
spreadsheet takes the same format as the table shown in Fig. 12.18 and has the 
advantage of being able to manipulate the data using the functions offered by a 
spreadsheet package. 

To export to a spreadsheet select option from the drop-down list in Fig. 12.17, click View 
Report. You must ensure that all other report filters are completed. The File Download 
dialogue box illustrated in Fig. 12.22 is displayed. 
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Fig. 12.22 Output to: Export to Spreadsheet 

You can either open the file from its current location, or, save the file to disk. 

To save the file to disk without opening the spreadsheet, click Save. 

This opens a new dialogue box prompting you to assign a filename and file location. 

1. To open the file, click Open. 

This opens the spreadsheet package and displays the report data. 

2. To save the open file, use the Save option in the spreadsheet utility. 

3. Once this is completed click OK to save the file. 

If on clicking the Save or Open button, the export to spreadsheet operation fails, then 
clear the browser cache. To do this for Internet Explorer: 

 from Tools menu select Internet Options

 on General tab click Delete Files

 on Delete Files dialogue box click OK.
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12.4 Service Reports 
Service reports can be accessed either directly from the Navigation Menu or from the 

service administration screen for a specific Service. 

12.4.1 Accessing Reports via the Navigation Menu 
From the Navigation Menu, click REPORTS AND GRAPHS 
> Service reports. The reports and graphs screen 
illustrated in Fig. 12.23 is displayed listing most of the 
available service reports. Only 10 reports are displayed on 
the screen at any one time. 

The remaining reports can be accessed by using the navigation buttons or the page 
control at the bottom of the screen. A list of all the available Service Reports is provided in 
Table 12.1. 

Fig. 12.23 Service Reports menu 

To access a report, click on the title of the report under Report Description. Clicking Call 
- CDR Export, for example, will display the screen illustrated in Fig. 12.27. 

 

12.4.2 Accessing Reports for a Service Name 
1. From the Navigation Menu click SERVICE ADMINISTRATION. 

The service administration screen in Fig. 12.24 is displayed. 
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Fig. 12.24 Service Administration screen 

2. Use the navigation buttons or the page control at the bottom of the screen to locate 
the desired Service Name. 

3. Click in the View column adjacent to the Service Name you wish to create a report 
on. 

The service administration Tabbed Display screen for the selected Service 

Name is displayed, as illustrated in Fig. 12.25. The screen defaults to the General 
Information page displaying the Service Name, Service ID, and Service Type. 

Fig. 12.25 Service page 

4. Click the Reports tab. 

The Reports & Statistics page for that Service is displayed, as illustrated in Fig. 
12.26. 
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Fig. 12.26 Reports for a specific Service 

5. Select the report you want by clicking on the report name hyper-link. 

Note: Only the reports applicable to the selected Service Name are available to 
you. 

All general Service Reports are listed in Table 12.1 below and are described in the 
subsequent sections. Each report can be accessed by clicking on the required link. 
Reports which are specific to a particular service type, are described in the relevant User 
Guide. 

 

 
Service Reports 

Report Type Report name 

Call Reports Call - CDR Export 

Call - Count to a Service 

Call - Hold Time for a Service 

Call - Interrogation by CLI 

Call - Repeat Attempt Details 

Call – Repeat Attempt Profile 

Regional Schema Reports Regional Schema - Post Code Mapping 

Scheduled Changes Reports Scheduled Changes - List by Service 

Service Type Reports Service Type - Variable Configuration 

Services Reports Services - List of Active Services 

Services - List of Dormant Services 

Voice & Data Capture Reports Voice & Data Capture - Session Data 

Table 12.1 All Service Reports 
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12.4.3 Call - CDR Export 
CDR export allows the user to extract all useful information about a call to spreadsheet 
format. Rather than containing just the criteria of a report, it contains all of the data held in 
the Statistics Data Warehouse (SDW) that can be displayed to a user. 

1. To access this report follow the procedures described in Accessing Reports via 
the Navigation Menu. 

2. The Call - CDR Export page in Fig. 12.27 is displayed where the report filters are 
applied. 

 
 

Fig. 12.27 Call - CDR Export - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. The available report filters are: 

 * From Date

 * To Date

 LOCAL/GMT Time Conversion

 * Service Name

 Summary or Detail report.

For instructions on how to use the report filters refer to Filtering Conventions 

4. Select the output format required. 

Only Export to Spreadsheet is available for this report. The export process is 
initialised when you click View Report. This process is described in Export to 
Spreadsheet. 

Note: The only indication of the report building, is by viewing the progress bar at the 
bottom of the screen 

5. Click View Report to display the report to the screen 
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The report is viewed within a spreadsheet application (usually Microsoft Excel) which is 
launched automatically once the report information has compiled. This process may take 
a few minutes depending on the size of the report. An extract of this report can be seen in 
Fig. 12.28 Call - CDR Export (Extract). 

Alternatively: 

 Click Cancel to reset the filters to their default settings

 Clicking Back returns you to the "Service Reports menu”.
 
 

Fig. 12.28 Call - CDR Export (Extract) 



Ride Web Interface Service Provider User Guide 
Issue A3h 27 April 2007. 

Copyright © 2004-2007 BT 

 

 
 

12.4.4 Call - Count to a Service 
Count to a Service allows you to view the number of calls to the service currently being 
viewed. You may input a date range to report on and then further filter call data into 
discrete time intervals by setting the Granularity filter (see “Filter into Discrete Time 
Periods – The Granularity Filter”. 

1. To access this report follow the procedures described in either: 

• "Accessing Reports via the Navigation Menu" or 

• "Accessing Reports for a Service Name" 

2. The Call - Count to a Service page in Fig. 12.29 is displayed where the report 
filters are applied. 

 

Fig. 12.29 Call - Count to a Service - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. The available report filters are: 

• * Regional Schema 

• * Regions (only if Regional Schema is selected) 

• * From Date 

• * To Date 

• Granularity 

• LOCAL/GMT Time Conversion 

• * Service Name 

You may also choose to filter the Call - Count to a Service report by a regional schema. 
For information on using this filter see Filter by Region - Regional Schema For 
instructions on how to use other report filters refer to Filtering Conventions 
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4. Select one of the following outputs: 

 • Table (see Output to Table)

• Export to Spreadsheet (see Export to Spreadsheet ) 

• Bar Chart (see “Output to Bar Chart”) 

5. Click View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.30 below. 

Alternatively: 

Click Cancel to reset the filters to their default settings 

Depending on how you accessed the report, clicking Back returns you to either the 
“Service Reports menu” or the “Reports for a specific Service”. 

Fig. 12.30 Building the Count to a Service report 

Note: The recommended outputs for the Call - Count to a Service report is either the 
Table format or the Bar Chart format as illustrated in Fig. 12.31. 

Fig. 12.31 Call - Count to a Service 

Click Print to print the report. 
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Click Back to return to the report filtering screen in Fig. 12.29. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in “Export to Spreadsheet”. 

 

12.4.5 Call - Hold Time for a Service 
Hold Time for a Service displays the total and average call hold times for a service 
grouped into discrete time periods across a defined time range. A summary is also 
provided to show the maximum and minimum call hold times across the range. 

1. To access this report follow the procedures described in either: 

• “Accessing Reports via the Navigation Menu” or 

• “Accessing Reports for a Service Name” 

2. The Call - Hold Time for a Service page in Fig. 12.32 is displayed where the 
report filters are applied. 

Fig. 12.32 Call - Hold Time for a Service - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * Regional Schema 

• * Regions (only if Regional Schema is selected) 

• * From Date 

• * To Date 

• Granularity 

• LOCAL/GMT Time Conversion 

• * Service Name 
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You may also choose to filter the Call - Hold Time for a Service report by a regional 
schema. For information on using this filter see “Filter by Region - Regional Schema” 
For instructions on how to use other report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see "Output to Table") 

• Export to Spreadsheet (see "Export to Spreadsheet") 

• Line Chart (see "Output to Line Chart") 

• Bar Chart (see “Output to Bar Chart”) 

5. Click View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.33 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Depending on how you accessed the report, clicking Back returns you to either the 
“Service Reports menu” or the “Reports for a specific Service”. 

Fig. 12.33 Building the Hold Time for a Service report 

Note: The recommended output for the Call - Hold Time for a Service report the Table 
format as illustrated in Fig. 12.34. 
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Fig. 12.34 Call - Hold Time for a Service report 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.32. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in “Export to Spreadsheet”. 
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12.4.6 Call - Interrogation by CLI 
Interrogation by CLI shows either a summary or a detailed list of all calls to a service, 
mapped by CLI. 

Accessing the report 

1. To access this report follow the procedures described in either: 

• “Accessing Reports via the Navigation Menu” or 

• “Accessing Reports for a Service Name” 

2. The Call - Interrogation by CLI page in Fig. 12.35 is displayed where the report 
filters are applied. 

Fig. 12.35 Call - Interrogation by CLI - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * Service Name 

• Calling Number (Optional) 

• * Summary or Detail report 

For instructions on how to use report filters refer to “Filtering Conventions” 

4. Select the output format required. The available output formats are: 

• Table (see “Output to Table”) 

• Export to Spreadsheet (see “Export to Spreadsheet”) 
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5. Click View Report to display the report. While the report is building, the screen will 
display the Building Report ... page illustrated in Fig. 12.36 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Depending on how you accessed the report, clicking Back returns you to either the 
“Service Reports menu” or the “Reports for a specific Service”. 

 

 
Fig. 12.36 Building the Interrogation by CLI report 

Note: The recommended output for the Call - Interrogation by CLI report is the Table 
format as illustrated in Fig. 12.37. 

Fig. 12.37 Call - Interrogation by CLI 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.35. 
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Click Download as Spreadsheet to download the data in spreadsheet format, 
which is described in “Export to Spreadsheet”. 

Depending on whether Detailed or Summary is selected from the Summary or 
Detailed report selection list, the report will return one of the following sets of data: 

 

 
Interrogation by CLI - Report Data 

Detailed Report Summary Report 

Calling Line Number Calling line number 

Total Call Duration Total call duration 

Clearing cause Number of calls 

Clearing reference Average time per call 

 Number of abnormally cleared calls 

12.4.7 Call - Repeat Attempt Details 
Repeat Attempt Details displays the top 20 CLIs based on the number of repeat calls 
made to one or more services within the criteria provided. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Call - Repeat Attempt Details page in Fig. 12.38 is displayed where the report 
filters are applied. 

Fig. 12.38 Call - Repeat Attempt Details - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 
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• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * Service Name 

• * Group By 

• * Sort By (Post Code, Regional Grouping or Call Count) 

For instructions on how to use report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see "Output to Table") 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

• Line Chart (see "Output to Line Chart") 

• Bar Chart (see "Output to Bar Chart") 

5. Click View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.39 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 

 
Fig. 12.39 Building the Repeat Attempt Details report 

Note: The recommended output for the Call - Repeat Attempt Details report is the Table 
format, an extract of which, is illustrated in Fig. 12.40. 
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Fig. 12.40 Call - Repeat Attempt Details report (formerly known as Call - Multiple CLI 
Screening) 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.38. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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12.4.8 Call - Repeat Attempt Profile 
Repeat Attempts Profile shows the number of callers that have called a certain number 
of times. It also shows the average interval between repeat calls and the percentage of 
the total vote which were repeat calls. 

This report is designed to show how callers could influence a vote by making repeat calls. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Call - Repeat Attempt Profile page in Fig. 12.41 is displayed where the report 
filters are applied. 

 
Fig. 12.41 Call - Repeat Attempt Profile - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * Service Name 

• * Threshold 

For details on using the report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see “Output to Table”) 

• Export to Spreadsheet (see “Export to Spreadsheet”) 
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5. Click View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.42 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 

 
Fig. 12.42 Building the Repeat Attempt Profile report 

Note: The recommended output for the Call - Repeat Attempt Profile report is the Table 
format, an extract of which, is illustrated in Fig. 12.43. 
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Fig. 12.43 Call - Repeat Attempt Profile report (Extract) 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.41. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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12.4.9 Regional Schema - Post Code Mapping 
Regional Schema - Post Code Mapping shows every Calling Line Identity (CLI) mapped 
to a postcode within a given region. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Regional Schema - Post Code Mapping page in Fig. 12.44 is displayed 
where the report filters are applied. 

Fig. 12.44 Regional Schema - Post Code Mapping - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * Regional Schema 

For details on using this report filter refer to “Filter by Region - Regional Schema” 

4. Select one of the following outputs: 

• Table (see “Output to Table”) 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.45 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 

Fig. 12.45 Building the Regional Schema - Post Code Mapping report 

Note: The recommended output for the Regional Schema - Post Code Mapping report is 
the Table format, an extract of which, is illustrated in Fig. 12.46. 



Ride Web Interface Service Provider User Guide 
Issue A3h 27 April 2007. 

Copyright © 2004-2007 BT 

 

 
 

 
Fig. 12.46 Regional Schema - Post Code Mapping report (extract) 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.44. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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12.4.10 Scheduled Changes - List by Service 
Scheduled Changes - List by Service provides a list of all scheduled variable and/or 
status updates for a particular Service. The report can also show all scheduled updates 
for all Services. 

The report allows the user to select a specific time frame in the future by means of the 
From Date and To Date filters. The report then displays all scheduled changes for the 
chosen Service within the set period. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Scheduled Changes - List by Service page in Fig. 12.47 is displayed where 
the report filters are applied. 

 

Fig. 12.47 Scheduled Changes - List by Service - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * Service Name 

For details on using the report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 
 

• Table (see “Output to Table”) 
• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.48 below. 
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Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 

 
Fig. 12.48 Building the Scheduled Changes - List by Service report 

Note: The recommended output for the Scheduled Changes - List by Service report is 
the Table format. 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.47. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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12.4.11 Service Type - Variable Configuration 
Service Type - Variable Configuration is designed to help a RIDE Interactive user view 
the set-up of a RIDE Interactive service. The report will return the variables on a service 
that have been modified from the default. Due to the number of variables on RIDE 
Interactive, it is difficult to work out how a service is configured. The report will display 
only those variables that are in use and the values to which they are set. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Service Type - Variable Configuration page in Fig. 12.50 is displayed where 
the report filters are applied. 

Fig. 12.50 Service Type - Variable Configuration - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * Service Name 

• List Type 

4. Select the output format required. 

Only Export to Spreadsheet is available for this report. The export process is 
initialised when you click View Report. This process is described in “Export to 
Spreadsheet” 

Note: The only indication of the report building, is by viewing the progress bar at the 
bottom of the screen 

5. Click View Report to display the report to the screen 

The report is viewed within a spreadsheet application (usually Microsoft Excel) 
which is launched automatically once the report information has compiled. This process 
may take a few minutes depending on the size of the report. An extract of this report can 
be seen in Fig. 12.51 ’Service Type - Variable Configuration report (extract)’. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 
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Fig. 12.51 Service Type - Variable Configuration report (extract) 
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12.4.12 Services - List of Active Services 
List of Active Services provides quick access to the entire list of active services for the 
Service Provider grouped into discrete time periods across a defined time range. The term 
‘active’ is used to describe services with activity levels over a user-defined threshold. The 
user may set the Call Threshold to a particular figure, or leave the threshold in the default 
value (1000 calls). 

Accessing the report: 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Services - List of Active Services page in Fig. 12.52 is displayed where the 
report filters are applied. 

Fig. 12.52 Services - List of Active Services - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * Regional Schema 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * More calls than (Call Threshold) 

You may also choose to filter the Services - List of Active Services report by a regional 
schema. For information on using this filter see “Filter by Region - Regional Filter 
Type” For instructions on how to use the other report filters refer to “Filtering 
Conventions” 

4. Select one of the following outputs: 

• Table (see “Output to Table”) 
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• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.53 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 

 

 
Fig. 12.53 Building the List of Active Services report 

Note: The recommended output for the Services - List of Active Services report is the 
Table format as illustrated in Fig. 12.54. 
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Fig. 12.54 Services - List of Active Services report 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.52. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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12.4.13 Services - List of Dormant Services 
List of Dormant Services provides quick access to the entire list of services with a 
particularly low call rate. for the Service Provider grouped into discrete time periods 
across a defined time range. 

The user may set the Call Threshold to a particular figure, or leave the threshold in the 
default value (1000 calls). Accepting the default value and running the report would return 
a list of services that received less than 1000 within the user specified time frame. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Services - List of Dormant Services page in Fig. 12.55 is displayed where 
the report filters are applied. 

Fig. 12.55 Services - List of Dormant Services - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * Regional Schema 

• * Regions 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * Fewer calls than (Call Threshold) 

You may also choose to filter the Services - List of Dormant Services report by a 
regional schema. For information on using this filter see “Filter by Region - Regional 
Filter Type” For instructions on how to use the other report filters refer to “Filtering 
Conventions” 

4. Select one of the following outputs: 
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• Table (see “Output to Table”) 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.56 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the “Service Reports menu”. 

 
 
 
 

 
Fig. 12.56 Building the List of Dormant Services report 

Note: The recommended output for the Services - List of Dormant Services report is 
the Table format, an extract of which, is illustrated in Fig. 12.60. 
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Fig. 12.57 Services - List of Dormant Services report (extract) 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.55. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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12.4.14 Service Type - Variable Configuration 
Service Type - Variable Configuration shows the variable configuration of a RIDE 
Interactive service. 

1. To access this report follow the procedures described in “Accessing Reports via 
the Navigation Menu”. 

2. The Service Type - Variable Configuration page in Fig. 12.58 is displayed where 
the report filters are applied. 

 

 
Fig. 12.58 Service Type - Variable Configuration - Filtering 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * Service Name. 

• List Type 

4. Select the output format required. 

Only Export to Spreadsheet is available for this report. The export process is 
initialised when you click View Report. This process is described in “Export to 
Spreadsheet” 

Note: The only indication of the report building, is by viewing the progress bar at the 
bottom of the screen 

5. Click View Report to display the report to the screen. 

The report is viewed within a spreadsheet application (usually Microsoft Excel) 
which is launched automatically once the report information has compiled. This process 
may take a few minutes depending on the size of the report. An extract of this report can 
be seen in Fig. 12.59 ’Service Type - Variable Configuration report (Extract)’. 

Alternatively: Click Cancel to reset the filters to their default settings. 
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Clicking Back returns you to the “Service Reports menu”. 
 
 

Fig. 12.59 Service Type - Variable Configuration report (Extract) 
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12.4.15 Voice & Data Capture - Session Data 
Voice & Data Capture - Session Data returns all captured session data for a service. At 
SP level only the session ID is listed. 

1. To access this report follow the procedures described in “Accessing Reports for a 
Service Name”. 

2. The Voice & Data Capture - Session Data page in Fig. 12.60 is displayed where 
the report filters are applied. 

Fig. 12.60 Voice & Data Capture - Session Data - filtering 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

For instructions on how to use the other report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 
 

• Table (see “Output to Table”) 
• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.61 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the "Reports for a specific Service”. 
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Fig. 12.61 Building the Voice & Data Capture - Session Data report 

Note: The recommended output for the Voice & Data Capture - Session Data report is 
the Table format as illustrated in Fig. 12.62. 

Fig. 12.62 Voice & Data Capture - Session Data report (extract) 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.60. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in “Export to Spreadsheet”. 
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12.5 Platform Reports 

12.5.1 Accessing the Platform Reports 
From the Navigation Menu click REPORTS AND GRAPHS > 
Platform Reports. The reports & graphs screen illustrated 
in Fig. 12.63 is displayed. 

 

 

Fig. 12.63 Platform Reports menu 

All Platform Reports are listed in Table 12.2 below and are described in the subsequent 
sections. Each report can be accessed by clicking on the required link. 

 

Platform Reports 

Audit Log - Platform 

Session Capacity – Utilisation snapshot by service 

Traffic Analysis - Busy Period Traffic 

User rights – access control privileges 

User - Access Log 

Table 12.2 Platform reports 
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12.5.2 Audit Log - Platform 
Audit Log - Platform provides the User with a means of tracing actions that have been 
executed by users at all levels of access. 

The types of events that are: 

 Logins to the RIDE Web Interface

 Failed Logins

 Remote Update Application Logins

 Scheduled Service Changes

 Completed Service Changes

 User Account Changes

 Report Access

1. To access this report follow the procedures described in “Accessing the Platform 
Reports”. 

2. The Platform _ Audit Log page in Fig. 12.64 is displayed where the report filters 
are applied. 

Fig. 12.64 Audit Log - Platform- Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * From Date 

• * To Date 

• * Severity Level 

• Event Number 

• Event Message Search 

• * Message Source 
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For instructions on how to use the report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see "Output to Table") 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.65 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the Platform Reports menu 

 
Fig. 12.65 Building the Audit Log - Platform report 

Note: The recommended output for the Platform _ Audit Log report is the Table format 
as illustrated in Fig. 12.66. 

Fig. 12.66 Audit Log - Platform report 

Click Print to print the report. 
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Click Back to return to the report filtering screen in Fig. 12.64. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in “Export to Spreadsheet”. 
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12.5.3 Session capacity – Utilisation snapshot by service 
Session Capacity - Utilisation Snapshot by Service provides information to show a 
break down of actual session allocation to a specific service within a defined time period. 

1. To access this report follow the procedures described in ‘Accessing the Reports’. 

2. Once the reports have been accessed, the Session Capacity - Utilisation 
Snapshot by Service page in Fig. 12.67 is displayed where the report filters are applied. 

 

Fig. 12.67 Session capacity – utilisation snapshot by service – filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. The available report filters are: 

 * Service Name (select a specific service or All Your Services)

 * Service Type (All V&DC Service Types (default), All FIVA Service Types, FIVA
- Without Call Distribution, FIVA - With Call Distribution, Message Link 2) • 

 * Report Type (By Service or By Service Type)

4. Select one of the following outputs: 

 Table

 Export to Spreadsheet

Click on View Report to display the report data. While the report is building, the screen will 
display the Building Report... page illustrated in Fig. 12.68. 

Fig.12.68 Building the Session Capacity – utilisation snapshot by service report 

Alternatively: Click Cancel to reset the filters to their default settings. 
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The output for the Session Capacity - Utilisation Snapshot by Service report illustrated 
in Fig. 12.69 is the Table format. 

Fig.12.69: Session capacity – utilisation snapshot by service report 
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Session Capacity - Utilisation Snapshot by Service Output parameters 

Column Heading Description 

Storage Used 
The number of sessions specified for the Session Storage Limit. 
The actual number of sessions created. 

% Storage Used The number of sessions created as a percentage of the Session 
Storage Limit 

 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.67. 

Click Download as Spreadsheet to download the data in spreadsheet format. 
 

12.5.4 Traffic Analysis - Busy Period Traffic 
Traffic Analysis - Busy Period Traffic lists the total number of calls, the total time of the 
calls and the total hourly time of the calls, in fixed granularity 15 minute segments, within a 
configurable period of time. 

1. To access this report follow the procedures described in “Accessing the Platform 
Reports”. 

2. The Traffic Analysis - Busy Period Traffic page in Fig. 12.70 is displayed where 
the report filters are applied. 

Fig. 12.70 Traffic Analysis - Busy Period Traffic - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 



Ride Web Interface Service Provider User Guide 
Issue A3h 27 April 2007. 

Copyright © 2004-2007 BT 

 

 

The available report filters are: 

• * Regional Schema 

• * Regions 

• * From Date 

• * To Date 

• LOCAL/GMT Time Conversion 

• * Service Name 

• Hourly Call Calculating Method 

For instructions on how to use the report filters, refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see “Output to Table”) 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

• Bar Chart (see “Output to Bar Chart”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.71 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the "Platform Reports menu”. 

 
Fig. 12.71 Building the Traffic Analysis - Busy Period Traffic report 

Note: The recommended output for the Traffic Analysis - Busy Period Traffic report is 
the Table format as illustrated in Fig. 12.72. 
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Fig. 12.72 Traffic Analysis - Busy Period Traffic report (extract) 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.70 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in “Export to Spreadsheet”. 
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12.5.5 User rights – access control privileges 
This report summarises access control privileges of all users under your control. 

1. To access this report follow the procedures described in “Accessing the Platform 
Reports”. 

2. The User rights - Access control privileges page in Fig. 12.73 is displayed where 
the report filters are applied. 

Fig. 12.73 User Rights - Access control privileges - Filter screen 

3. Select the only available report filter parameter, which is mandatory (*): 

• * User ID 

For instructions on how to use the report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see "Output to Table") 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen may display the Building Report ... page illustrated, but this may not be seen 
because the report is generally produced very quickly. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the "Platform Reports menu”. 

Note: The recommended output for the User - Access Log report is the Table format as 
illustrated in Fig. 12.74. 
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Fig. 12.74 User rights - access control privileges report 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.73. 

Click Download as Spreadsheet to download the data in spreadsheet format, which 
is described in “Export to Spreadsheet”. 
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User - Access Log 

User - Access Log details all login activity whether successful or unsuccessful. 

1. To access this report follow the procedures described in “Accessing the Platform 
Reports”. 

2. The Users - Access Log page in Fig. 12.75 is displayed where the report filters are 
applied. 

Fig. 12.75 User - Access Log - Filter screen 

3. Select the report filter parameters ensuring that all mandatory (*) parameters are 
selected. 

The available report filters are: 

• * From Date 

• * To Date 

• * Sort Column (Audit Date or User ID) 

For instructions on how to use the report filters refer to “Filtering Conventions” 

4. Select one of the following outputs: 

• Table (see “Output to Table”) 

• Export to Spreadsheet (see “Export to Spreadsheet”) 

5. Click on View Report to display the report data. While the report is building, the 
screen will display the Building Report ... page illustrated in Fig. 12.76 below. 

Alternatively: Click Cancel to reset the filters to their default settings 

Clicking Back returns you to the "Platform Reports menu”. 



Ride Web Interface Service Provider User Guide 
Issue A3h 27 April 2007. 

Copyright © 2004-2007 BT 

 

 
 

 
Fig. 12.76 Building the User - Access Log report 

Note: The recommended output for the User - Access Log report is the Table format as 
illustrated in Fig. 12.77. 

Fig. 12.77 User - Access Log report 

Click Print to print the report. 

Click Back to return to the report filtering screen in Fig. 12.75. 

Click Download as Spreadsheet to download the data in spreadsheet format, which is 
described in “Export to Spreadsheet”. 
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13 TALK TO US 

13.1 Introduction 
This facility provides the user with a utility to send feedback to the BT service Centre. 
These messages will be dealt with but will never receive the urgent attention reserved for 
fault reports. Do not use this facility to report service problems. 

 

13.2 Accessing the Report 
1. From the Navigation Menu click TALK TO US. 

The talk to us screen in Fig. 13.1 is displayed. 

 
 

Fig. 13.1 Talk to us screen 

2. Enter your message or request ensuring that all mandatory (*) information is 
completed. 
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The following information is required: 
 

Field Name Description 

* Full Name Automatically completed 

* Email Address Automatically completed 

* Subject A meaningful title to give your message or request 

* Message Details of your message or request 

* Type Click the appropriate radio button to indicate whether 
your communication is of a Technical or General 
nature 

Table 13.1: required input information. 

When you have completed writing your communication: 

3. Click Send. A confirmation dialogue box, illustrated in Fig. 13.2 is displayed. 

Alternatively, click Clear. A confirmation dialogue box, illustrated in Fig. 13.3 is 
displayed. Clicking OK will clear the Subject and Message text boxes. 

 
 

Fig. 13.2 Send message confirmation dialogue box 

 

 
Fig. 13.3 Clear message confirmation dialogue box 

4. To send the message, click OK. As illustrated in Fig. 13.4, confirmation that your 
message has been sent, is displayed to the screen. 
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Fig. 13.4 Message sent 

Your communication will be emailed to the appropriate Super User responsible for your 
services. 

To close the talk to us window, click in the top right hand corner of the window. 

 

14 FAULT REPAIR AND OUT OF HOURS ASSISTANCE 

All faults with the service must be reported to 0800 110011 (option 1) where the service 
repair team are available at all times to deal with your problem. You should not use this 
team to fix problems which are under your own control e.g. password re-sets or to request 
announcement update. 

Dedicated out of hours support can be made available at a cost and this must be 
negotiated well in advance of the event. This can be arranged via your account team. 
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15 APPENDICES 

15.1 Appendix A - Introduction to Microsoft Sound 
Recorder 

In order to customise service announcements, the user must first record the required 
announcements using a sound recorder utility. Announcements must also be recorded in 
the correct file format for deployment to the service nodes. 

Microsoft Sound Recorder allows users to record announcements for upload to the RIDE 
Web Interface. The various features of sound recorder are shown in Fig. 14.1. 

Microsoft Sound Recorder is opened by opening the Start menu, choosing All Programs- 
> Accessories -> Entertainment, and then clicking Sound Recorder. 

 

Fig. 14.1 Recording Announcements - Microsoft Sound Recorder 

Record - Starts recording from the selected input source (refer to 
paragraph 14.1.1). 

Play - Replays the recording from the selected position. 

Stop - Halts the playback of recordings. 

Seek-to-End - Jumps to the end of a recording. 

Seek-to-Start - Returns to the beginning of a recording. 

Position - Displays the position of the slider within the recording 
duration. 

Length - Displays the total length of the recording. 

Waveform Display - Displays a graphical representation of the 
recorded sound wave. 

Slider - Allows the user to jump to any point in a recording. Hold the 
left mouse-button down on the slider and drag it to the required 
position. 
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15.1.1 Selecting an Input Source 
Before a recording can be made an audio input device must be selected to provide an 
audio source. 

1. Click on the Start menu, and choose All Programs-> Accessories -> Entertainment, 
and then click Volume Control. 

This opens the Volume Control window similar to that shown in Fig. 14.2. 

Fig. 14.2 Selecting an Input Source - Master Volume Control 

2. Select Properties from the ‘Options’ menu. 

The Properties window will be displayed (Fig. 14.3). 

3. Click on the radio button labelled Recording and ensure that the appropriate 
checkbox is selected for the required input source. 

Fig. 14.3 Selecting an Input Source - Master Volume Control Properties 

4. Once this has been completed, click on OK to close the window and show the 
recording controls for the selected input source(s). 
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Fig. 14.3 shows that the following input sources were selected: ‘CD Player’, ‘Microphone’ 
and ‘Line In’. Hence, the volume controls displayed in the Recording Control window are 
those shown in Fig. 14.4. 

Fig. 14.4 Selecting an Input Source - Recording Controls 

5. Tick the checkbox for the intended input source. If the intended input source is a 
microphone, selecting the microphone checkbox has the effect of de-selecting all others. 

6. Close the Recording Control window. Microsoft Sound Recorder will now use the 
selected input device. 

 

15.1.2 Making a Recording 
To make a new recording you must first select an audio input device (paragraph 14.1.1). 
Once a device has been selected as the audio source, configure Sound Recorder to 
record in the required file format. 

1. Open the Sound Recorder, as described in paragraph 14.1, select Properties from 
the ‘File’ menu. The Properties for Sound window shown in Fig. 14.5 will be displayed. 

2. Select Recording formats from the drop-down list and click on Convert Now… to 
open the Sound Selection window (Fig. 14.6). 
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Fig. 14.5 Making a Recording - Microsoft Sound Recorder Properties 

3. Select CCITT A-Law from the ‘Format’ drop-down list. 

4. Select 8.000kHz, 8 Bit, Mono - 7kb/sec from the ‘Attributes’ drop-down list. 

Fig. 14.6 Making a Recording - Announcement File Format 

5. Click on OK to update the recording format and close the Sound Selection 
window. 

6. Now click on OK to exit from the Properties for Sound window. 

Any recordings made using Sound Recorder will now record and save files in the correct 
file format. 

To make a recording: 

1. Open the Sound Recorder, as described in paragraph 14.1. 

2. Choose New from the File menu. 

3. To start recording, click on the Record button. 

4. To stop recording at any time, click the Stop button. 

5. To play the new recording, click on the Play button. 

6. Choose Save from the File menu. 
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7. Assign a file name and location for the new sound file. 

Refer to paragraph 14.1.8 for details of announcement file calibration. 
 

15.1.3 Modifying Recordings 
Once a recording has been made, it can then be modified in the following ways: 

The recording may added to an existing recording (refer to paragraph 14.1.4). 

Portions of the recording may be over-written (refer to paragraph 14.1.5). 

The recording may be discarded (refer to paragraph 14.1.6). 

Portions of the recording may be deleted (refer to paragraph 14.1.7). 
 

15.1.4 Adding to an Existing Recording 
Existing recordings may be added to by using Microsoft Sound Recorder. 

1. Unless the file to be added to is already open in Sound Recorder, choose Open 
from the ‘File’ menu. This displays the Open File window. Locate the file to be modified 
and click once on the file name. Now click on Open to open the file in Sound Recorder. 
Follow the steps detailed below: 

2. Click on the Seek-to-end button. 

3. Prepare the audio to be recorded and click the Record button. 

4. To stop recording, click the Stop button. 

5. The new recording is added to the end of the original. 

6. To review the new extended recording, click on the Play button. 

7. To undo any changes to an unsaved recording, choose Revert from the ‘File’ menu 
and click OK to confirm the restoration to the original recording. 

Note: When a file is saved, no changes can be undone. 

8. To continue to add to the recording, repeat steps 2-4. 

9. Choose Save from the ‘File’ menu to save the changes under the current file name. 

Alternatively, choose Save As from the ‘File’ menu to save the modified recording as a 
new file. Assign a file name and location for the new sound file. 

 

15.1.5 Over-writing Recordings 
If required, an existing recording may be over-written - either entirely or in part. 

1. Unless the file to be over-written is already open in Sound Recorder, choose Open 
from the ‘File’ menu. This displays the Open File window. Locate the file to be modified 
and click once on the file name. Now click on the button labelled Open to open the file in 
Sound Recorder. Follow the steps detailed below: 

2. Use the slider to locate the position from which the recording will be over-written. 

3. Prepare the audio to be recorded and click the Record button. 

4. To stop recording, click the Stop button. 
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5. The new recording over-writes the remainder of the original. 

6. To review the new recording, click the Play button. 

7. To undo any changes to an unsaved recording, choose Revert from the ‘File’ menu 
and click OK to confirm the restoration to the original recording. 

Note: When a file is saved, no changes can be undone. 

8. Choose Save from the ‘File’ menu to save the change under the current file name. 

Alternatively, choose Save As from the ‘File’ menu to save the modified recording as a 
new file. Assign a file name and location for the new sound file. 
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15.1.6 Discard a Recording 
Recordings may be discarded completely with any of the following procedures. 

 Choose New from the ‘File’ menu and select No when prompted to save any changes.

 Click the Seek-to-end button, and then choose Delete Before Current Position from the 
‘Edit’ menu. Click OK to confirm the dialogue prompt.

 Click the Seek-to-start button, and then choose Delete After Current Position from the 
‘Edit’ menu. Click OK to confirm the dialogue prompt.

 

15.1.7 Delete Portions of a Recording 
Specific portions of a recording may be deleted in Microsoft Sound Recorder. Recordings 
can be deleted. Follow the procedure outlined below. 

1. Move the slider to the position where the deletion should start (or end). 

2. Choose either Delete Before Current Position (i.e. delete the entire recording 
from zero seconds up to the position of the slider) or Delete After Current Position (i.e. 
delete the entire recording from the position of the slider up to the end of recording) from 
the ‘Edit’ menu. 

3. To undo any changes to an unsaved recording, choose Revert from the ‘File’ menu 
and click OK to confirm the restoration to the original recording. 

Note: When a file is saved, no changes can be undone. 

4. Choose Save from the ‘File’ menu to save the change under the current file name. 

Alternatively, choose Save As from the ‘File’ menu to save the modified recording as a 
new file. Assign a file name and location for the new sound file. 

 

15.1.8 Announcement Calibration 
The recommended method for calibrating recordings is based on using the human ear to 
compare a test recording with a calibration recording, which is available for download from 
the RIDE platform. 

The following procedure should be used in order to properly calibrate a recording: 

1. Use Sound Recorder to make a test recording by following the steps detailed in 
paragraph 14.1.2 ’Making a Recording’. 

2. Use Sound Recorder to alternately play back first the test recording and then the 
calibration file. 

3. Based on the comparison between the two files, adjust the recording volume of the 
selected input device (refer to paragraph 14.1.1) and then re-record the test recording. 

4. Continue until there is no noticeable difference between the calibration recording 
and the test recording. 

Once the recording volume/level is set correctly and the microphone is set the same 
distance from the mouth, each recording should be at an acceptable level. However each 
recording should be checked using the steps above to confirm the level and to check for 
hiss, hum, crackles, pops etc. 
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Tips: 

 Do not speak louder or quieter to adjust the recording volume - use the recording 
volume control (see paragraph 14.1.1).

 Avoid rooms with air-conditioning or fans that produce sub-sonic noise that can 
become audible when recorded.

 To play back the calibration file and the test recording, open two instances of Microsoft 
Sound Recorder.
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16 GLOSSARY AND ABBREVIATIONS 
 

ASCII American Standard Code for Information Interchange 

BHCA Busy Hour Call Attempts 

BT British Telecom 

CDR Call Data Record 

CPM Calls per Minute 

CLI Calling Line Identity 

CSV Comma separated values 

DDI Direct Dial In 

DISP Distributed Services Intelligent Platform 

DTD Document Type Definition 

DTMF Dual Tone Multi Frequency 

EN End Node 

FN Function Node 

GIF Graphics Interchange Format 

GMT Greenwich Mean Time 

GUI General User Interface 

HTML Hypertext Mark Up Language 

HTTPS Secure Hypertext Transfer Protocol 

ICSTIS Independent Committee for the Supervision of Telephone Information Standards 

ID Identifier 

IMS Intelligent Media Server 

IP Internet Protocol 

IPS Intelligent Programmable Switch 

JPEG Joint Photographic Experts Group 

MEM Mediation Element Manager 

MSS Master Statistics Summariser 

NIP Network Intelligent Platform 

ODBC Open DataBase Connectivity 

PC Personal Computer 

PIN Personal Identification Number 

PIUR Product Independent Usage Record 

Acronym Expansion 
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PSTN Public Switched Telephone Network 

RAM Random Access Memory 

RDL Remote Download 

RIDE Recorded Information Distribution Equipment 

RTS Real Time Statistics 

RUD Remote Update 

SACI Service Application Configuration Interface 

SCPU Statistics Collection and Processing Unit 

SCU System Control Unit 

SDW Statistics Data Warehouse 

SIV Session Index Variable 

SMD Service Management Database 

SMU Service Management Unit 

SN Start Node 

SP Service Provider 

SPA Service Provider Administrator 

SPU Service Provider User 

SS7 Signalling System No. 7 

TIS Telephone Information Services 

VoIP Voice over Internet Protocol 

V&DC Voice and Data Capture 

WAV Windows Audio File Format 

XML Extensible Markup Language 

Acronym Expansion 


